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1 본본본본 문서의문서의문서의문서의 목적목적목적목적 

본 문서의 목적은 Atlassian 

문서입니다. 사용자 분들께서

내용들을 기술하고 있습니다

1.1 제품제품제품제품 버전버전버전버전 

Atlassian – Confluence

Confluence 

 

본 설명서에 사용되는 제품의

있습니다.  본 제품에 대한 

https://confluence.atlassian.com/conf58/confluence

 

1.2 사용자사용자사용자사용자 가이드가이드가이드가이드 설명설명설명설명 내용내용내용내용

본 사용자 가이드에서 설명하고 있는

기본기본기본기본 기능기능기능기능(Getting Started) 

• 대시보드 

• 키보드 단축키(Keyboard Shortcut)

스페이스스페이스스페이스스페이스(Space) 

• 스페이스 생성 

• 개인 스페이스 생성 

• 스페이스 편집 

• 스페이스 삭제 

• 스페이스 압축 
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Atlassian Confluence에서 자주 사용하는 기능에 대한 내용을 설명하는

분들께서 궁금해 하시는 스페이지, 페이지, 차일드(Child) 등의 기능과

있습니다.  

Confluence 

 5.8.10 

제품의 버전은 2015년 9월 30일 현재 Confluence 5.8.10 

 온라인 영문 사용자 가이드는 아래의 링크에서 확인하실 수 

https://confluence.atlassian.com/conf58/confluence-documentation-home

내용내용내용내용 

있는 내용은 다음과 같습니다.  

(Keyboard Shortcut) 

 

설명하는 사용자 가이드 

기능과 페이지 편집에 대한 

Confluence 5.8.10 버전을 사용하고 

 있습니다.  

home-771891740.html 
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• 스페이스 액티비티 

페이지와페이지와페이지와페이지와 블로그블로그블로그블로그(Pages & Blog Post)

• 페이지 생성 및 수정 

• 블로그 포스팅 

• 에디터 사용 방법 

• 페이지 이동과 재정렬 

• 페이지 복사 

• 페이지 삭제 및 복구 

• 레이블 추가, 삭제 및 검색

• 페이지 제한 걸기 

• 태스크 추가, 할당, 보기

• 템플릿 사용하기 

• 콘텐츠를 컨플루언스오 

• 페이지 정보 출력 

파일파일파일파일 처리처리처리처리(Files) 

• 파일 업로드  

• 파일 및 이미지 표시하기

• 파일 관리 

• 파일을 이용한 협업 기능

• 오피스 파일 편집하기 

협업협업협업협업(Collaboration) 

• 네트워킹 살펴보기 

Atlassian Confluence 5.8.X User Guide 
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(Pages & Blog Post) 

 

검색 

보기 

 임포트하기 

표시하기 

기능 
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• 사용자 상태 업데이트 

• 멘션 사용하기 

• 페이지와 블로그 포스트

• 페이지와 블로그 포스트에

• 이메일 알림 추가 

• 페이지, 스페이스, 블로그

개인개인개인개인 설정설정설정설정 

• 프로필 살펴보기 

• 패스워드 변경하기 

• 사용자 설정 편집 

• 프로필 사진 지정 

• 홈페이지 선택 

• 스페이스와 페이지 즐겨찾기

검색검색검색검색 

• 컨플루언스 검색 문법 

• 컨플루언스 검색 필드 

• 사용자 디렉터리 검색 

• 최근 보여진 페이지와 블로그
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포스트 공유하기 

포스트에 코멘트 추가하기 

블로그 와치(Watch) 

즐겨찾기 설정 

 

 

 

블로그 포스트 
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2 기본기본기본기본 기능기능기능기능 

2.1 대시보드대시보드대시보드대시보드 

대시보드는 컨플루언스 사이트의

가능한 스페이스에 대한 정보와

현재 보여지고 있는 페이지 어디에서든

화면으로 전환이 가능합니다. 사이트의

로고 이미지로 변경되어 있을 수

대시보드는 아래의 항목으로 분류되어

• Welcome message: 

메시지를 출력합니다

• Get started: 관리자를

시스템 관리자에게만

• Spaces, Pages, Network: 

하단에 존재합니다. 

� Spaces – 사용자가

� Pages -  즐겨찾기로

� Network – 팔로잉을

• Recent activity: 대시보드의

� Popular – 최근에

� All Updated 

� Favorite Space 

� Network -  팔로잉하고

� Space Categories 

업데이트된 항목을

Atlassian Confluence 5.8.X User Guide 
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사이트의 가장 기본이 되는 페이지로 로그인을 하면 볼 수 있으며, 사이트에

정보와 최근에 업데이트된 페이지들의 리스트를 제공합니다. 

어디에서든 왼쪽 상단에 있는 컨플루언스의 사이트 로고를 선택함으로써

사이트의 로고는 기본 컨플루언스의 로고이지만 사이트 관리자에

수 있습니다. 

분류되어 있습니다. 

Welcome message: 대시보드의 왼쪽 상단에 나타나는 정보로써 컨플루언스

출력합니다. 

관리자를 위한 빠른 설정 가이드를 제공하며, 대시보드의 이 영역은

관리자에게만 보여집니다. 

Spaces, Pages, Network: 이 탭들은 즐겨찾기한 콘텐츠, 사용자를 표시하며

 

사용자가 권한을 가진 모든 스페이스에 대해 즐겨찾기로 표시된

즐겨찾기로 표시된 페이지를 표시합니다.  

팔로잉을 하고 있는 사용자의 목록을 보여줍니다. 

대시보드의 오른쪽에 위치하고 있으며, 최근에 업데이트된 콘텐츠를

최근에 생성되어 “좋아요(liked)”버튼을 눌렀거나, 코멘트를 한

All Updated -  권한을 가진 모든 스페이스의 업데이트된 콘텐츠를 보여줍니다

Favorite Space – 즐겨찾기로 지정된 스페이스의 모든 업데이트된 콘텐츠를

팔로잉하고 있는 사용자에 의해 만들어진 업데이트 항목을 표시합니다

Space Categories – 스페이스 카테고리를 선택하고, 카테고리 내의 스페이스로부터

항목을 보여줍니다. 

 

사이트에 대한 개요, 접근 

선택함으로써 대시보드 

관리자에 의해 해당 회사의 

컨플루언스 관리자에 의해 지정된 

영역은 컨플루언스 관리자와 

표시하며 대시보드의 왼편 

표시된 스페이스를 보여줍니다. 

콘텐츠를 표시합니다. 

한 페이지를 보여줍니다.  

보여줍니다. 

콘텐츠를 보여줍니다.  

표시합니다.  

스페이스로부터 최근에 
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2.2 키보드키보드키보드키보드 단축키단축키단축키단축키 

페이지를 편집하고 컨플루언스의

있습니다.  

컨플루언스에서 키보드 단축키를

• 스크린의 오른쪽 상단의

• 페이지를 보고 싶은 

• 에디터에서 키보드 단축키는

키보드 단축키 다이얼로그에서는

• General – 글로벌(global), 

• Editor -  텍스트 편집과

• Editor Autoformatting 

Atlassian Confluence 5.8.X User Guide 
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컨플루언스의 화면을 빠르게 보기 위한 방법으로 키보드 단축키가 효과적으로

단축키를 보기 위해서 아래와 같이 따라하면 됩니다. 

상단의 Help 아이콘 을 선택하고 Keyboard Shortcuts

 때에는 Shift+? 버튼을 누릅니다. 

단축키는 에디터 툴바의 물음표 표시를 누르면 됩니다. 

다이얼로그에서는 다음의 정보를 보여줍니다. 

(global), 페이지(page), 블로그 포스트(blog post)에 대한

편집과 포맷팅에 대한 단축키 

Editor Autoformatting – 위키 마크업과 자동 포맷팅 단축키 

 

 

효과적으로 사용될 수 

Keyboard Shortcuts를 선택합니다. 

대한 단축키 
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아래는 컨플루언스의 다양한 환경에서

 

모든모든모든모든 화면에서화면에서화면에서화면에서(All Screen) 

Shortcut Action 

/ 빠른 검색을

Ctrl+S Submit (where a form is active). Editor 

Outside the editor 

G then D 대시보드로

G then S 현재 스페이스

G then G 검색 박스로

? 키보드 단축키

[ 사이드바 토클

 

에디터에디터에디터에디터 내에서내에서내에서내에서 

Shortcut Action

Ctr+0 문단스타일

Ctr+(1–6) 헤드라인

Ctr+7 사전에

Ctr+8 블록

Ctrl+Shift+A 매크로

Ctrl+B 선택된

Ctrl+Shift+B 지정된

Ctrl+Shift+D 위키

Ctrl+Shift+E 편집

Ctrl+F 검색

Ctr+I 

(letter I, not 

number 1) 

선택된

Ctrl+Shift+J JIRA 

Ctrl+K 링크

Atlassian Confluence 5.8.X User Guide 
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환경에서 사용 가능한 키보드 단축키의 목록을 나타낸 것입니다

 

검색을 활성화 

Submit (where a form is active). Editor – 페이지 저장 

Outside the editor – 브라우저 페이지를 저장 

대시보드로 이동  

스페이스 보기 

박스로 커서 이동 

단축키 설명 

토클 

Action 

문단스타일 적용 

헤드라인 레벨을 현재 행에 적용 

사전에 지정된 포맷 스타일을 적용 

블록 지정 스타일을 적용 

매크로 브라우저 열기 

선택된 텍스트를 굵게(bold) 만들기 

지정된 텍스트를 목록형태(bulleted list)로 지정 

위키 마크업을 삽입(위키 마크업 다이얼로그 열기) 

편집 중인 페이지의 프리뷰 

검색 치환(Find and Replace) 툴바 실행 

선택된 문자열을 이탤릭체로 바꿈 

JIRA 이슈를 삽입(JIRA 이슈 다이얼로그를 실행 

링크 삽입(링크 다이얼로그 실행) 

 

것입니다. 
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Ctrl+Shift+K 권고하는

Ctrl+M 이미지

Ctrl+Shift+M 선택된

Ctrl+Shift+N 넘버

Ctrl+S 편집중인

Ctrl+Shift+S 스트라이크를

Ctrl+U 선택된

Ctrl+Y 이전

Ctrl+Z 최근

Tab 현재

Shift+Tab 현재

Shift+Enter 문단에서

 

에디터의에디터의에디터의에디터의 테이블테이블테이블테이블 속성속성속성속성 

Windows Action 

Ctrl+Shift+c 현재 테이블

Ctrl+Shift+i 테이블 삽입

Ctrl+Shift+v 클립보드로부터

Ctrl+Shift+x 커서가 위치는

Alt+Up Arrow 현재 행 위에

Alt+Down 

Arrow 
현재 행 아래에

 

에디터에디터에디터에디터 내내내내 자동자동자동자동 완성완성완성완성 기능기능기능기능 

Shortcut Action 

[ 페이지 자동 완성

! 이미지 작업에

{ 타이핑하는 매크로

@ 멘션 대상 사용자의

// 날짜 입력기를
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권고하는 페이지의 목록을 보거나 페이지를 다른 위치로 보내도록 함 

이미지 삽입(파일 및 이미지 삽입 다이얼로그 열기) 

선택된 이미지 목록, 문서와 페이지에 포함할 다른 파일들을 보여줌  

넘버 리스트로 텍스트 변환 

편집중인 페이지 저장 

스트라이크를 포함하는 텍스트로 변환 

선택된 텍스트에 언더라인을 표시 

이전 수행했던 명령어를 다시 실행 

최근 수행된 명령에 대한 되돌리기(undo) 수행 

현재 줄에서 들여쓰기를 수행(숫자 또는 기호 리스트에서만 작동됨) 

현재 줄에서 내어쓰기를 수행(숫자 또는 기호 리스트에서만 작동됨) 

문단에서 강제로 라인을 넘기기. 별도의 공백이 없는 개행 

 

테이블 또는 선택된 행을 복사 

삽입(테이블 입력 다이얼로그 실행) 

클립보드로부터 테이블 행들을 붙여넣기를 하며, 현재 행의 상단에 배치 

위치는 테이블 행 또는 선택된 행들을 잘라내기 

위에 행을 추가 

아래에 새로운 행을 추가 

완성 대상 목록을 보여주거나 페이지의 링크를 보여줌 

작업에 대한 작업 목록을 보여주거나, 페이지내에 포함시킬 멀티미디어 파일과

매크로 이름의 목록을 보여줌 

사용자의 목록을 보여줌 

입력기를 사용하여 날짜를 입력. 날짜 입력은 dd/mm/yyyy or dd-mm-yyyy.

 

  

 

 

 

Mac OS X 

Cmd+Shift+c 

Cmd+Shift+i 

Cmd+Shift+v 

Cmd+Shift+x 

Alt+Up Arrow 

Alt+Down 

Arrow 

파일과 문서를 보여줌 

yyyy.포맷을 통해 트리거 
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스크린스크린스크린스크린 보기보기보기보기 

Shortcut Action 

B 블로그 포스트

C 현재 페이지의

E 페이지나 블로그

K 링크 다이얼로그를

L 레이블 추가 또는

M 페이지나 블로그

S 현재 페이지 공유

T 첨부파일 보기

V 페이지 보기로

W 새로운 감시자

 

파일파일파일파일 미리미리미리미리 보기보기보기보기 

Shortcut Action 

Left arrow 파일 파일 

Right arrow 이전 파일 

Up arrow 이 파일의 

Down arrow 이 파일의 

Esc 파일 미리 

 

2.3 컨플루언스컨플루언스컨플루언스컨플루언스 백업백업백업백업 및및및및 복원복원복원복원

컨플루언스를 백업 또는 복원하기

1. 우측 상단의 톱니바퀴

Atlassian Confluence 5.8.X User Guide 

Page 13 

포스트 생성 

페이지의 자식 페이지를 생성 

블로그 포스트를 편집하거나 프리뷰 모드에서 편집 모드로 돌아옴 

다이얼로그를 실행 

또는 편집 

블로그 포스트에 코멘트 추가 

공유 

보기 

보기로 전환 (페이지 첨부파일 보기 중에만 사용가능) 

감시자 추가 및 편집 

 

 보기 

 보기 

 이전 페이지 보기(전체 프리젠테이션 모드에서 사용) 

 다음 페이지 보기(전체 프리젠테이션 모드에서 사용) 

 보기 또는 전체 프리젠테이션 모드에서 빠져나오기 

복원복원복원복원 

복원하기 위해서 다음과 같은 방법을 사용할 수 있습니다.  

톱니바퀴 모양을 클릭 한 뒤 General Configuration을 클릭합니다

 

클릭합니다. 
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2. Backup & Restore

 

3. Back Up 버튼을 클릭합니다
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Backup & Restore를 클릭합니다.  

 

클릭합니다. 
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4. 다음의 위치에 zip파일이

 

5. 복원의 경우 Step4

직접 넣어 복원하는 

전자의 경우 파일 선택

클릭합니다. 

후자의 경우 지정된 

보여지며, Restore
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파일이 생성됩니다. 이후 해당 파일을 복원하려는 서버에 업로드합니다

Step4에서 만들어진 zip파일을 윈도우 등에서 업로드 하는 경우와

 두 가지의 방법이 있습니다.  

선택 버튼을 클릭 후 해당 zip파일을 선택한 뒤 Upload and Restore 

 home 디렉토리에 zip파일을 넣은 뒤 페이지를 새로고침할

, Restore버튼을 클릭하여 복원합니다 

 

 

업로드합니다. 

 

경우와 home 디렉토리에 

Upload and Restore 버튼을  

새로고침할 경우 하단에 zip파일이 
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6. Restore 버튼 클릭

 

7. 완료 시 다음과 같은

 

2.4 컨플루언스컨플루언스컨플루언스컨플루언스 백업백업백업백업 스케쥴링스케쥴링스케쥴링스케쥴링

일정한 시간마다 자동으로 백업을

1. 우측 상단의 톱니바퀴모양을

2. 좌측 패널의 CONFIGURAION 

클릭하여, 생성되는 
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클릭 시 다음과 같은 화면이 나타납니다. 

같은 화면이 나타납니다. 

스케쥴링스케쥴링스케쥴링스케쥴링 

백업을 수행하도록 설정할 수 있습니다.  

톱니바퀴모양을 클릭한 뒤, General Configuration을 선택합니다

CONFIGURAION 메뉴의 Backup Administraion을 클릭합니다

 백업의 파일명을 수정할 수 있습니다.  

 

 

 

선택합니다.  

클릭합니다. 이후 Edit 버튼을 
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3. 다시 1의 과정으로 

클릭합니다.  
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 돌아간 뒤, 좌측 패널의 ADMINISTRAION 메뉴의 Scheduled Jobs

 

 

 

Scheduled Jobs를 
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4. Back Up Confluence

 

5. Cron Expression

첫 번째: 초 (0-59) 

두 번째: 분 (0-59) 

세 번째: 시 (0-23) 

네 번째: 월간 중 특정 날짜 (1-

다섯 번 째: 월 (1-12 or JAN

여섯 번 째: 주중 특정 날짜 (1-

일곱 번 째: 년 (1970-2099)
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Back Up Confluence메뉴의 Edit를 클릭합니다.  

Cron Expression에 따라 원하는 시간대를 지정합니다.  

-31) 

12 or JAN-DEC) 

-7 or SUN-SAT) 

) 
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3 스페이스스페이스스페이스스페이스(Space) 

컨플루언스 스페이스(Cofluence Space)

개념이며, 다음의 두 가지 핵심 기능을

• Site spaces – ‘Global

있는 영역입니다. 

• Personal spaces – 

사용자에 의해 보여지거나

목록으로 보여집니다. 

NOTE. 스페이스스페이스스페이스스페이스 관리자관리자관리자관리자

 모든모든모든모든 스페이스는스페이스는스페이스는스페이스는 적어도적어도적어도적어도

스페이스스페이스스페이스스페이스 관리자를관리자를관리자를관리자를 해당해당해당해당

권한을권한을권한을권한을 설정함으로써설정함으로써설정함으로써설정함으로써 스페이스에스페이스에스페이스에스페이스에

스페이스스페이스스페이스스페이스 관리자는관리자는관리자는관리자는 전체전체전체전체

일반적인일반적인일반적인일반적인 컨플루언스컨플루언스컨플루언스컨플루언스 사용자사용자사용자사용자

 

스페이스는 아래와 같이 페이지, 하위

 

컨플루언스 대시보드에서 모든 스페이스에
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(Cofluence Space)는 콘텐츠와 관계된 페이지와 블로그 포스트를 담고

기능을 가지고 있습니다. 

Global’스페이스라 불리는 것으로 다른 사용자들과 협업을 수행하거나

 사용자들이 개별적으로 가질 수 있는 개인 스페이스로 프라이빗하게

보여지거나 편집될 수 있는 영역입니다. 개인 스페이스는 People Directory 

 

관리자관리자관리자관리자 

적어도적어도적어도적어도 한한한한 명명명명 이상의이상의이상의이상의 스페이스스페이스스페이스스페이스 관리자를관리자를관리자를관리자를 가지고가지고가지고가지고 있습니다있습니다있습니다있습니다. 일반적으로일반적으로일반적으로일반적으로

해당해당해당해당 스페이스를스페이스를스페이스를스페이스를 생성한생성한생성한생성한 사용자이며사용자이며사용자이며사용자이며, 해당해당해당해당 스페이스에스페이스에스페이스에스페이스에 대해대해대해대해 사용자들에사용자들에사용자들에사용자들에

스페이스에스페이스에스페이스에스페이스에 대한대한대한대한 접근접근접근접근, 보기보기보기보기, 수정수정수정수정 등의등의등의등의 권한을권한을권한을권한을 제공할제공할제공할제공할 수수수수 있습니다있습니다있습니다있습니다

전체전체전체전체 컨플루언스컨플루언스컨플루언스컨플루언스 관리자관리자관리자관리자(confluence administrator)가가가가 아니며아니며아니며아니며

사용자사용자사용자사용자 중중중중 한한한한 명입니다명입니다명입니다명입니다.  

하위 페이지 구조를 가지며,  각 페이지들은 첨부파일들의 목록을

 

스페이스에 대한 정보를 아래의 그림과 같이 확인하실 수 있습니다

 

담고 있는 컨테이너의 

수행하거나 콘텐츠 생성할 수 

프라이빗하게 보호되거나 다른 

People Directory 내에서 

일반적으로일반적으로일반적으로일반적으로 

사용자들에사용자들에사용자들에사용자들에 대한대한대한대한 

있습니다있습니다있습니다있습니다. 

아니며아니며아니며아니며, 

목록을 가질 수 있습니다. 

있습니다.  
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3.1 스페이스스페이스스페이스스페이스 생성생성생성생성 

사용자의 필요에 따른 각각의 팀, 프로젝트

space를 통해 기존의 페이지를 이동하거나

스페이스에 대한 권한에 접근하기 위해서는

1. 컨플루언스 상단의 Spaces > Create space

2. 생성하고 싶은 스페이스의

3. Name 과 Space Key

Create 를 선택합니다.

생성한 스페이스를 사용자들이 보게

생성합니다. 스페이스 청사진(blueprints)

또한 개인 스페이지 지정, 다른 사용자와의

 

 

스페이스스페이스스페이스스페이스 키키키키 
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프로젝트 또는 혼합된 형태의 스페이스를 생성할 수 있습니다

이동하거나, 블로그 포스트에 대한 작업을 수행할 수 있습니다

위해서는  

Spaces > Create space 를 클릭합니다. 

스페이스의 유형을 선택한 후 Next 를 클릭합니다. 

Space Key를 포함하는 페이지 상세 정보를 입력하고 다른 필요한 정보를

. 

보게 될 관련 정보를 표시하도록 커스터마이징할 수 있는 홈페이지를

(blueprints)은 팀원과 같은 부가 기능들의 홈페이지를 가지게 됩니다

사용자와의 공유 등의 작업을 수행할 수 있습니다. 

 

있습니다. 컨플루언스의 create 

있습니다.  

정보를 입력한 다음 

홈페이지를 자동으로 

됩니다. 
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각 스페이스는 유일한 식별키인 스페이스

사용됩니다. 스페이스 생성시 키를 

입력하는 것이 가능합니다.  

예를 들어 마케팅 팀의 스페이스 키를

활용하여 접근을 수행할 수 있습니다

http://my.confluenceSite.com/display/marketing/

스페이스 키의 조건은 다음과 같습니다

• 반드시 유일해야 함 

• 모든 문자, 숫자를 사용하는

• 최대 255자까지 지정 가능

주의해야 할 점은 스페이스 키를 생성하는

조심해야 합니다. 

스페이스에는 다음과 같은 유형의 스페이스가

• Team space - 인트라넷에서

구성원을 표시하고, 각 사용자에게

• Knowledge Base space 

가이드(How-to)와 트러블

경우 원하는 형태로 페이지를
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스페이스 키(space key)를 가지며 이 값을 스페이스를 위한 URL

 입력하도록 하고 있으며, 기본 스페이스 키를 보다 기억하기

키를 ‘marketing’이라고 지정한 경우, URL에서는 아래와 같은

있습니다. 

http://my.confluenceSite.com/display/marketing/ 

 

같습니다. 

사용하는 것이 가능 

가능 

생성하는 경우 개인 사용자 스페이스의 이름으로 하는 경우 중복이

스페이스가 존재합니다. 

인트라넷에서 컨플루언스를 사용하거나, 팀을 관리하는 경우 사용할

사용자에게 서로 다른 권한을 줄 수 있습니다. 

Knowledge Base space -  콘텐츠를 스페이스에서 쉽게 검색할 수 있도록 하는

트러블 슈팅 아티클의 두 페이지 블루프린트를 포함하고 있습니다

페이지를 커스터마이징할 수 있습니다.  

 

URL의 일부분으로 

기억하기 쉬운 형태의 키를 직접 

같은 스페이스키를 

중복이 발생하므로 

사용할 수 있으며, 팀의 

하는 것으로 사용자 

있습니다. 이 템플릿을 사용하는 
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• Documentation space 

홈페이지는 검색과 페이지

 

스페이스스페이스스페이스스페이스 권한권한권한권한(Space Permission)

각 스페이스가 생성되면 기본 권한을

administrator)’권한을 가지게 되며

됩니다.  

스페이스에 대한 권한의 할당은 각 

스페이스에 대한 권한에 접근하기 위해서는

4. 사이드바 하단의 Space tools > Permissions 

5. Edit Permissions를 

Space Permissions 페이지에서

1. 헤더 부분의 Browse > Space Admin

2. Space administration options

3. Edit Permissions 를

 

‘Edit Space Permissions’ 페이지에서는

• Groups – 사이트에 액세스

• Individual Users – 사이트에

• Anonymous Access 
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Documentation space – 이 스페이스는 사이드바 내의 전체 페이지 트리와 공유

페이지 레이블을 사용하여 검색하기 쉽도록 구성됩니다.  

(Space Permission) 

권한을 갖게 됩니다. 스페이스를 생성한 사용자는 자동적으로 ‘스페이스

되며, 다른 사용자들과 그룹에게 스페이스에 대한 권한을 부여할

 사용자 또는 그룹에게 적용 가능합니다. 

위해서는  

Space tools > Permissions 을 선택합니다. 

 선택합니다. 

페이지에서 

Browse > Space Admin를 선택합니다. 

ation options의 Permissions를 선택합니다. 

를 선택합니다. 

페이지에서는 다음의 영역으로 구분되어 있습니다. 

액세스 가능한 권한을 가진 그룹의 목록 

사이트에 접근 가능한 권한을 가진 사용자의 목록 

Anonymous Access – 모든 익명 사용자에 대한 허가된 스페이스 권한 

 

공유 링크를 표시합니다. 

스페이스 관리자(space 

부여할 수 있는 자격이 생기게 
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권한 목록에 새로운 사용자 또는 그룹을

해당 목록에 나타나게 되며, 권한을

그룹이나 사용자의 이름이 확실하지

카드(*)를 사용하여 권한을 지정할 

권한을 전체로 할당하거나 없애는 경우

가능합니다. 

 

3.2 스페이스스페이스스페이스스페이스 편집편집편집편집 

스페이스 상세는 이름, 설명, 홈페이지와

있습니다. 또한 스페이스 키를 보는

스페이스 상세정보를 편집하기 
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그룹을 추가하기 위해서 각 항목 내에 있는 Add 버튼을 선택합니다

권한을 할당할 사용자와 그룹에 체크박스를 표시한 후 Save all 을

확실하지 않은 경우에는 아이콘을 선택하여 검색할 수 있습니다. 

 수도 있습니다. 

경우 Actions 로부터 Select All 또는 Deselect All 을

홈페이지와 스페이스에 대한 상태로 스페이스 관리자인 경우 페이지를

보는 것이 가능하지만, 해당 내용을 편집하지는 못합니다. 

 위해서는 

 

 

선택합니다. 그룹과 사용자가 

을 선택합니다. 

. 또한 필요에 따라 와일드 

을 선택하여 지정하는 것도 

페이지를 수정할 수 
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1. 스페이스로 이동하여

사용하는 경우 상단의

2. Edit Space Details

3. 다음의 항목을 업데이트합니다

• Name 

• Description 

• Status  

• Home page 

편집이 완료되면 Save 버튼을

 

3.3 스페이스스페이스스페이스스페이스 삭제삭제삭제삭제 

스페이스를 영구적으로 삭제하고

합니다. 스페이스를 삭제하기 이전에

데이터를 잃을 수 있는 위험이 존재합니다

스페이스를 삭제하게 되면 XML 

유의해야 합니다.  
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이동하여, 하단의 Space tools > Overview를 선택합니다. Documentation 

상단의 Browse > Space Admin을 선택합니다. 

Edit Space Details를 선택합니다. 

업데이트합니다. 

 

Home page – 스페이스 내의 페이지 이름을 입력하고, 새로운 홈페이지

버튼을 눌러 변경 사항을 적용하도록 합니다. 

삭제하고, 콘텐츠를 제거하기 위해서는 스페이스에 대한 관리자 권한을

이전에 스페이스에 대한 XML 백업을 설정하는 것이 필요합니다

존재합니다.  

XML 스페이스 백업을 가지고 있지 않은 경우 복구할 방법이 전혀

 

. Documentation 테마를 

홈페이지 이름을 지정합니다. 

 

권한을 가지고 있어야 

필요합니다. 그렇지 않으면 모든 

전혀 없으므로 이 점을 
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스페이스를 삭제하기 위해서는 

1. 스페이스로 이동하여

2. Delete Space 를

3. OK 버튼을 클릭합니다

스페이스가 Documentation Theme

1. 상단의 Browse > Space Admin

할당되어 있지 않으면

2. 스페이스 관리자 옵션의

3. OK 를 선택하여 스페이스를

 

3.4 스페이스스페이스스페이스스페이스 압축압축압축압축 

스페이스가 존재하고 있지만 보여지지

스페이스 관리자 권한을 가지고

스페이스 전체를 다시 보기 위해서

스페이스를 보관하기 위해서 아래의

1. 스페이스 선택한 후 

2. Edit Space Details

3. 드롭다운 메뉴의 St

4. Save 를 선택합니다
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 아래의 작업 순서로 진행하면 됩니다. 

이동하여 하단의 Space tools > Overview 링크를 수행합니다.

를 선택합니다. 

클릭합니다. 

Documentation Theme를 사용하고 있는 경우 아래와 같은 절차로 삭제를 

Browse > Space Admin을 선택합니다.(confluence-administrator 

않으면 페이지가 보이지 않을 수 있습니다) 

옵션의 Delete Space를 선택합니다. 

스페이스를 삭제합니다. 

보여지지 않도록 스페이스를 보관하는 것이 가능합니다. 스페이스

가지고 있어야 합니다.  

위해서, 언제든 보관된 스페이스의 상태를 변경하면 됩니다. 

아래의 작업 순서로 진행합니다. 

 하단 사이드바의 Space tools > Overview 를 선택합니다

Edit Space Details를 선택합니다. 

Status에서 Archived를 선택합니다. 

선택합니다. 

 

. 

 진행합니다. 

administrator 그룹의 사용자로 

스페이스 보관을 위해서는 

선택합니다. 
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스페이스가 보관모드로 선택되면

 

3.5 스페이스스페이스스페이스스페이스 액티비티액티비티액티비티액티비티 

스페이스 액티비티 정보는 기본적으로

플러그인이 설치되어 있지 않으면

만약 활성화되어 있는 경우 스페이스

있습니다. 

• 페이지, 블로그가 얼마나

• 가장 인기있는 콘텐츠

• 가장 활성화된 콘텐츠

• 컨트리뷰터나 편집자가

 

스페이스 내의 액티비티를 보기

1.  스페이스를 선택하고, 사이드바
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선택되면 페이지와 콘텐츠가 더 이상 보여지지 않게 됩니다.  

기본적으로 비활성화(disabled)되어 있습니다. ‘Confluence Usage Stats

않으면 ‘Activity’ 탭이 보여지지 않게 됩니다.  

스페이스 액티비티 스크린이 각 스페이스에 대해 표시되어지며, 

얼마나 많이 조회되었는지 여부와 일정 기간 동안 추가되거나 

콘텐츠 

콘텐츠 

편집자가 가장 액티브하게 활동하는 콘텐츠 

보기 위해서 아래의 순서로 진행합니다. 

사이드바 하단의 Space Tools를 선택합니다. 

 

Confluence Usage Stats’ 

, 아래의 내용이 포함되어 

 업데이트된 상태 
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2. Activity를 선택합니다.

해당 링크를 선택하는 경우 페이지, 

 

 

최신의 업데이트된 콘텐츠를 확인하기

를 선택하도록 합니다. 

 

3.6 스페이스스페이스스페이스스페이스 권한설정권한설정권한설정권한설정 

전제사항전제사항전제사항전제사항 

1. 테스트를 위해 admin 이라는
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. 

, 블로그에 대한 액티비티의 목록이 표시되어집니다. 

확인하기 위해서는 상단의 Browse > Pages 메뉴를 선택 한 후

이라는 이름의 관리자 계정을 생성합니다.  

 

 

 

후 Recently Updated 
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2. test1, test2, test3이라는

 

3. 테스트를 위해 임의로 시스템

 

4. test1과 test2는 시스템운영
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이라는 이름의 일반 사용자 계정을 생성합니다. 

시스템 운영과 금투서비스 라는 이름의 그룹을 생성합니다.  

시스템운영 그룹에, test3는 금투서비스 그룹에 추가합니다. 

 

 

 

 

 



Confidential 

Global Permission 설정설정설정설정 

1. 우측 상단의 톱니바퀴모양

 

2. 좌측 하단의 Users & Security

 

3. 다음 화면에서 Edit Permissions 

 

4. 다음과 같이 시스템운영과
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톱니바퀴모양 – General configuration을 선택합니다.  

 

Users & Security의 Global Permissions를 선택합니다. 

 

Edit Permissions 버튼을 클릭합니다. 

시스템운영과 금투서비스 그룹을 추가합니다. 
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5. 다음과 같이 시스템운영

Administrator권한을

 

Public Space 생성생성생성생성 

1. 상단의 Spaces – Create space
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시스템운영 그룹에는 Personal Space, Create Space, System 

권한을 부여하며, 금투서비스 그룹에는 Personal Space권한만

Create space를 클릭합니다. 

 

 

Personal Space, Create Space, System 

권한만 부여합니다. 
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2. 상단의 Spaces – Create space

 

3. Public For Alll이라는

 

4. 스페이스 생성 후 좌측 하단의

Atlassian Confluence 5.8.X User Guide 

Page 31 

 

Create space를 클릭합니다. 

이라는 이름의 스페이스를 생성합니다. 

하단의 Space tools메뉴에서 Permissions를 클릭합니다

 

 

 

클릭합니다. 
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5. Edit Permissions를 

 

6. 다음과 같이 시스템운영과

 

7. 시스템운영 그룹에게는 Page Add
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 클릭합니다. 

시스템운영과 금투서비스 그룹을 추가합니다 

Page Add권한을, 금투서비스 그룹에게는 View 권한만 부여합니다

 

 

 

부여합니다. 
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8. 이후, test1, test2, test3 

test1과 test2는 해당 

Page생성은 불가능함을

NOTE. 위와위와위와위와 같이같이같이같이 Permission

따로따로따로따로 존재하며존재하며존재하며존재하며,  Global Permission

세부적인세부적인세부적인세부적인 권한을권한을권한을권한을 설정합니다설정합니다설정합니다설정합니다

 

Personal Space 생성생성생성생성 

1. 일반 사용자인 test1 

2. 우측 상단의 프로필 

 

3. Create 버튼을 클릭하여
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, test1, test2, test3 계정으로 접속한 뒤 Public For All 스페이스가 보이는지

 스페이스에서 Page를 생성가능하며, test3의 경우 스페이스에

불가능함을 확인할 수 있습니다 

Permission 에는에는에는에는 Global Permission 과과과과 Space Permission

,  Global Permission 을을을을 통한통한통한통한 넓은넓은넓은넓은 범위의범위의범위의범위의 권한권한권한권한 설정설정설정설정 이후이후이후이후, 각각각각 Space

설정합니다설정합니다설정합니다설정합니다.  

test1 사용자로 로그인 합니다.  

 버튼을 눌러 Add Personal Space버튼을 클릭합니다. 

 

클릭하여 Personal Space를 추가합니다 

 

보이는지 확인합니다. 또한 

스페이스에 접근은 가능하지만 

Space Permission 이이이이 

Space 별로별로별로별로 
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4. 상단의 Create 버튼을

 

5. test1’s Priavate Page
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버튼을 클릭합니다. 

s Priavate Page이라는 이름의 페이지를 생성합니다. 
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6. test2와 test3 사용자로

볼 수 있는지 확인합니다

space가 타 사용자에게

NOTE. Admin 사용자의사용자의사용자의사용자의

가능합니다가능합니다가능합니다가능합니다.  

 

일반일반일반일반 사용자의사용자의사용자의사용자의 Public Space 

1. 앞의 Global Permission

부여하였기에 test1, test2 

차이가 있음을 확인할

2. test1 사용자의 로그인
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사용자로 접속한 뒤 test1의 personal space 및 test1’s Priavate Page

확인합니다. 보여지지 않는 것이 정상이며, test2와 test3의 경우에도

사용자에게 보여지지 않는 것을 확인할 수 있습니다. 

사용자의사용자의사용자의사용자의 경우경우경우경우 개인의개인의개인의개인의  Personal Space 를를를를 볼볼볼볼 수수수수 있음은있음은있음은있음은 물론물론물론물론, 

Public Space 생성제한생성제한생성제한생성제한 

Global Permission설정의 마지막 단계에서 Create Space 권한은 시스템운영

test1, test2 사용자로 접속하였을 경우와, test3 사용자로 접속하였을

확인할 수 있습니다.  

로그인 화면 

 

 

s Priavate Page페이지를 

경우에도 각각의 personal 

, 삭제삭제삭제삭제 또한또한또한또한 

시스템운영 그룹에게만 

접속하였을 경우 다음과 같은 
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3. test3 사용자의 로그인

 

3.7 스페이스스페이스스페이스스페이스 생성생성생성생성 후후후후 Team 

스페이스 생성 이후 새로운 팀 멤버를

1. 좌측 하단의 Space tools
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로그인 화면 

Team member 생성생성생성생성 및및및및 삭제삭제삭제삭제 

멤버를 추가로 등록하거나 삭제하기 위해선 다음과 같은 방법을

Space tools에서 Permissions메뉴를 선택합니다.  

 

 

 

 

방법을 사용하시면 됩니다.  
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2. Individual Users 

 

3. 하단에 생성되는 빈 

 

4. test2 유저가 추가된

 

5. 테이블의 Actions 라인의

클릭합니다. 
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Individual Users 파트에서 Edit Permissions 버튼을 클릭합니다. 

 칸에 추가할 사용자를 검색한 뒤 Add버튼을 클릭합니다. 

추가된 것을 확인할 수 있습니다. 

라인의 톱니바퀴모양을 클릭하여 Select all로 권한을 부여한

 

 

 

 

 

부여한 뒤 Save all 버튼을 
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유저를 제거하는 경우 위의 상태에서

유저가 삭제되는 것을 확인할 수
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상태에서 톱니바퀴모양을 클릭하여, 모든 권한을 제거한 뒤 Save all

수 있습니다. 

 

 

Save all버튼 클릭 시 해당 
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4 페이지와페이지와페이지와페이지와 블로그블로그블로그블로그(Pages and Blog Posts)

페이지와 블로그는 컨플루언스 내의

콘텐츠는 페이지라는 이름으로 생성이

개인 스페이스를 포함하는 각 컨플루언스

있습니다.  

 

4.1 페이지페이지페이지페이지 생성생성생성생성 및및및및 수정수정수정수정 

페이지를 생성하기 위해서 컨플루언스

페이지들은 모든 중요한 정보를

에디터를 통해 텍스트, 작업, 이미지

Create를 선택하고 Blank Page

있습니다. 에디터를 사용하여 페이지의

가능합니다.  

콘텐츠를 추가하고 나면 하단의

가능하며, Save 버튼을 눌러 수정중인

페이지 view 모드를 통해 볼 수

있습니다. 
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(Pages and Blog Posts) 

내의 정보를 공유하고 캡처할 수 있도록 해주는 두 가지 방법입니다

생성이 가능하며, 이를 다른 사용자들이 확인할 수 있도록 도와줍니다

컨플루언스 스페이스는 페이지를 생성하여 넣을 수 있으며, 블로그

컨플루언스 어디에서든 상단의 Create 버튼을 눌러 페이지를 생성할

정보를 저장하는 도구이며, 빈 페이지를 사용하여 시작한 후 워드 프로세서와

이미지, 매크로와 링크, 미팅 노트 등을 추가할 수 있습니다.  

Blank Page를 통해 페이지를 생성하게 되면 자동으로 컨플루언스 

페이지의 이름을 재지정하는 것이 가능하며, 콘텐트 추가와 포맷을

하단의 Preview 버튼을 눌러 페이지가 저장되기 전 표시되는 형태에

수정중인 페이지를 저장합니다. 

수 있으며, Edit 버튼을 클릭하거나, E 버튼을 클릭하여 편집 

 

방법입니다. 공유하고자 하는 

도와줍니다.  

블로그 포스트를 생성할 수 

생성할 수 있습니다. 

프로세서와 같은 

 

 에디터를 사용할 수 

포맷을 변경하는 것이 

형태에 대한 미리보기가 

 

 모드로 다시 돌아갈 수 
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컨플루언스 페이지 생성 시 다양한

활용하여 손쉽게 페이지를 구성할

 

각 페이지에서 나타나는  

• 페이지 복사 

• 페이지 삭제 또는 특정

• 페이지 변경에 대한 

• 페이지 히스토리 정보

• 페이지 콘텐츠 검색 

• 페이지의 MS-Word, PDF, HTML 

• 페이지 링크 추가 
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다양한 형태의 템플릿을 사전에 제공하고 있으며, 페이지의 성격에

구성할 수 있는 방법을 제공합니다.  

버튼을 활용하여 아래와 같은 작업들을 수행할 수 있습니다

특정 버전의 페이지 삭제 

 상태 알림 

정보 보기 및 페이지 버전 비교 

 

Word, PDF, HTML 또는 XML로 내보내기 

 

 

성격에 따른 템플릿을 

있습니다. 
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4.2 에디터에디터에디터에디터 사용사용사용사용 방법방법방법방법 

컨플루언스 에디터는 페이지를 

콘텐츠를 입력할 수 있으며, 포맷팅과

NOTE. 페이지를페이지를페이지를페이지를 편집하기편집하기편집하기편집하기

합니다합니다합니다합니다. 

에디터는 페이지의 제목을 변경하고

도와줍니다. 

 

에디터에디터에디터에디터 툴바툴바툴바툴바(Editor Toolbar)

에디터 툴바는 페이지 레이아웃을

사용됩니다. 또한 찾기와 치환에
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 생성하거나 코멘트를 추가하는 경우 사용할 수 있습니다. Word 

포맷팅과 다른 콘텐츠, 파일과 같은 항목을 페이지 내에 삽입하는

편집하기편집하기편집하기편집하기 위해서는위해서는위해서는위해서는 ‘Add Pages’ 권한이권한이권한이권한이  스페이스에스페이스에스페이스에스페이스에  대해대해대해대해 있어야있어야있어야있어야

변경하고 텍스트, 이미지, 링크 등을 포함하는 본문 콘텐츠를 입력할

(Editor Toolbar) 

레이아웃을 지정하거나 링크, 테이블, 이미지, 첨부파일과 매크로를 추가할

치환에 사용되고, 도움말 아이콘 을 클릭하여 도움말을 볼 수 

 

. Word 문서와 같이 

삽입하는 것을 도와줍니다. 

있어야있어야있어야있어야 

입력할 수 있도록 

 

추가할 때 유용하게 

 있습니다. 
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Insert 메뉴메뉴메뉴메뉴 

위의 그림에서 보이는 Insert 메뉴가

도와주는 기능을 제공합니다. 

• 이미지 

• 외부 URL 또는 페이지

• 이모티콘, 심볼, 가로선

• 사전 정의된 매크로 

각 입력 내용은 앞서 정의한 키보드

• [ : 링크 삽입 

• ! : 이미지 또는 다른

• { : 매크로 삽입 

단축키를 사용하는 경우 각 기능에
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메뉴가 가장 중요하게 사용되며, 페이지 상의 아래의 콘텐츠 입력을

 

페이지 링크 

가로선 

 

키보드 단축키로도 모두 입력이 가능합니다. 

다른 미디어 삽입 

기능에 대한 자동 완성 기능을 포함하고 있습니다. 

 

 

입력을 손쉽게 하도록 
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페이지페이지페이지페이지 제한제한제한제한, 레이블레이블레이블레이블, 알림알림알림알림 

페이지 편집 시 페이지를 보거나

있도록 레이블을 삽입할 수 있습니다

있는 다른 사용자에게 알려주는

 

자동자동자동자동 포맷팅포맷팅포맷팅포맷팅 기능기능기능기능 

입력하는 문자열에 대해 자동으로

마크업을 통해 이루어집니다.  도움말

 

복사된복사된복사된복사된 링크링크링크링크 자동자동자동자동 컨버팅컨버팅컨버팅컨버팅 기능기능기능기능 

외부에서 복사된 URL을 페이지에서

표시되어야 할 콘텐츠를 정렬하는

• YouTube 비디오 

• JIRA 이슈 쿼리들 

• 구글 맵 

• 다른 컨플루언스 페이지

• Skitch의 공유된 스크린샷

• 웹에서 복사된 이미지

 

드래그드래그드래그드래그-앤앤앤앤-드롭드롭드롭드롭 

에디터 패널에서 이미지를 드래그하거나

이미지 상에 마우스를 대면 커서가

위치로 끌면 이동하게 됩니다. 

NOTE. 드래그드래그드래그드래그-앤앤앤앤-드롭기능은드롭기능은드롭기능은드롭기능은
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보거나 편집할 수 있는 사용자를 제한하고 싶을 수도 있으며, 페이지가

있습니다. 저장을 하거나, 코멘트를 넣었을 때 해당 내용의 변경

알려주는 알림 기능을 추가하는 것이 가능합니다.  

자동으로 포맷팅 해주는 기능을 컨플루언스는 제공하고 있으며, 이는

도움말 에서 Edit Autoformatting 기능을 살펴보면 됩니다

 

페이지에서 붙여넣기 하는 경우 에디터는 자동으로 그것을 분석하여

정렬하는 기능을 가지고 있습니다. 예를 들면 아래와 같은 기능들입니다

 

 

페이지, 블로그, 코멘트, 사용자 상태, 사용자 프로필 등 

스크린샷 

이미지 등 

드래그하거나, 다른 페이지에서 이미지나 매크로를 드래그할 수 

커서가 드래그-앤-드롭 아이콘( )으로 변하게 되며, 해당 아이콘을

 

드롭기능은드롭기능은드롭기능은드롭기능은 크롬크롬크롬크롬, 파이어폭스파이어폭스파이어폭스파이어폭스, 인터넷인터넷인터넷인터넷 익스플로러익스플로러익스플로러익스플로러 10 을을을을 지원합니다지원합니다지원합니다지원합니다

 

페이지가 쉽게 검색될 수 

변경 사항을 페이지를 보고 

이는 컨플루언스 위키 

됩니다. 

분석하여 페이지에서 

기능들입니다. 

 있습니다. 매크로나 

아이콘을 클릭 후 새로운 

지원합니다지원합니다지원합니다지원합니다. 
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변경된변경된변경된변경된 코멘트코멘트코멘트코멘트 기록과기록과기록과기록과 팔로워팔로워팔로워팔로워 알림알림알림알림

페이지 편집을 완료했을 때 다른

페이지 히스토리에서 확인이 가능합니다

또한 변경 사항이 해당 페이지에

대한 Notify watchers를 선택한

 

4.3 페이지페이지페이지페이지 이동과이동과이동과이동과 재정렬재정렬재정렬재정렬 

컨플루언스 내의 페이지의 위치를

페이지를 생성한 후 기존의 페이지를

페이지를 이동하기 위해서는 아래의

1. 페이지 편집 중에는 페이지

> Move를 선택합니다

2. ‘Set Page Location

페이지(Parent Page)

3. 자식 페이지들 간의 서로

4. Move 버튼을 클릭하여
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알림알림알림알림 

다른 사람이 변경된 것을 알릴 수 있는 기능을 제공합니다. 코멘트가

가능합니다.  

페이지에 관심을 가진 사용자(Watcher)에게 알리는 기능을 제공하고

선택한 후 코멘트를 하게 되면 해당 사용자들에게 이메일 알림이

 

위치를 바꾸는 가장 쉬운 방법은 페이지가 이동하고자 하는 스페이스로

페이지를 복사하는 것입니다. 

아래의 같은 절차를 통해 이동하도록 합니다. 

페이지 상단의 위치 아이콘 을 선택하고, 페이지가 생성된 후라면

선택합니다. 

Set Page Location’ 다이얼로그의 왼쪽 탭에서 새로운 스페이스를 찾고, 적용될

(Parent Page)를 선택합니다. 

서로 다른 위치로 옮기기를 원한다면 Reorder를 선택합니다. 

클릭하여 페이지를 옮깁니다. 

 

코멘트가 기록된 정보는 

제공하고 있는데 변경 사항에 

알림이 제공합니다. 

스페이스로 이동하여, 새로운 

후라면 오른쪽 상단의 

적용될 페이지의 상위 
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페이지는 선택된 새로운 위치로

합니다.  

스페이스 내의 페이지 재정렬 

스페이스 내에서 페이지의 새로운

제공합니다. 

• 단일 페이지 또는 페이지

• 동일한 상위 페이지를

페이지 내의 모든 링크들은 유지

됩니다.  

페이지를 이동하거나 재정렬하기

1. 스페이스로 이동하여

2. 이동하고자 하는 페이지의

3. 트리 내의 새로운 위치로

선택적으로 하위 페이지의 그룹을
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위치로 변경이 되며, 컨플루언스는 변경된 페이지로 모든 연결된 링크를

 

새로운 위치로 변경하고 페이지를 재정렬할 수 있습니다. 이 기능을

페이지 그룹, 스페이스 내의 다른 상위 페이지로 이동 

페이지를 가진 하위 페이지들의 재정렬 

유지 관리되며, 페이지가 이동되었을 때 나머지 하위 페이지들도

재정렬하기 위해서 아래의 절차를 따릅니다. 

이동하여 사이드바의 하단의 Space tools > Reorder pages

페이지의 위치로 트리를 확장합니다. 

위치로 페이지를 드래그합니다. 

그룹을 알파벳의 순서로 정렬할 수 있습니다.  

 

링크를 자동으로 업데이트 

기능을 다음과 같은 이점을 

페이지들도 동일하게 이동하게 

Space tools > Reorder pages 를 선택합니다. 
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4.4 페이지페이지페이지페이지 복사복사복사복사 

페이지를 생성할 경우 기존의 사용되었던

방법은 페이지를 복사하는 것입니다

페이지로 이름을 변경해야 하는데

제목을 변경합니다.  

페이지를 복사하기 위해서 아래의

1. 스페이스 내의 페이지로

기본적으로 페이지의

2. 페이지의 이름을 변경하고

스페이스의 페이지로

Location을 선택한

3. Save를 선택하여 저장합니다

NOTE. 복사된복사된복사된복사된 페이지는페이지는페이지는페이지는

페이지의페이지의페이지의페이지의 코멘트는코멘트는코멘트는코멘트는 복사되지복사되지복사되지복사되지

 

4.5 페이지페이지페이지페이지 삭제삭제삭제삭제 및및및및 복구복구복구복구 

컨플루언스의 페이지 삭제는 여러분이

페이지가 완전히 삭제되지 않는

페이지 삭제 시 페이지가 가지고

모든 버전을 포함하는 페이지를
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사용되었던 동일한 페이지를 만들고 싶을 때가 있는데 이 때 유용하게

것입니다. 페이지를 복사할 때는 기존의 동일한 스페이스 내에서

하는데 컨플루언스는 자동으로 'Copy of [originalPageName]'

아래의 절차를 수행하면 됩니다. 

페이지로 간 다음 > Copy를 선택하고, 에디터 내에서 페이지

페이지의 이름은 'Copy of [originalPageName]'으로 정의됩니다

변경하고 페이지 본문의 변경이 되야 하는 내용을 편집합니다. 

페이지로 옮겨져야 하거나 다른 상위 페이지에 포함되어야 하는 경우

선택한 후 페이지를 이동하도록 합니다. 

저장합니다. 

페이지는페이지는페이지는페이지는 모두모두모두모두 동일한동일한동일한동일한 첨부파일과첨부파일과첨부파일과첨부파일과 레이블을레이블을레이블을레이블을 똑같이똑같이똑같이똑같이 가지게가지게가지게가지게 되지만되지만되지만되지만, 

복사되지복사되지복사되지복사되지 않습니다않습니다않습니다않습니다.  

여러분이 사용하는 윈도우와 같이 휴지통으로 이동하도록 되어

않는 한 해당 페이지는 휴지통에 남아 있게 됩니다.  

가지고 있는 모든 버전을 삭제할 수도 있으며, 페이지의 특정 버전을

페이지를 삭제하는 경우 아래와 같은 절차를 따르면 됩니다. 

 

 

유용하게 사용할 수 있는 

내에서 서로 다른 이름을 가진 

'Copy of [originalPageName]'의 이름으로 페이지 

페이지 복사본을 엽니다. 

정의됩니다. 

. 만약 페이지가 다른 

경우 왼쪽 하단의 

, 원본원본원본원본 

되어 있습니다. 해당 

버전을 삭제할 수도 있습니다.  



Confidential 

• 페이지로 이동하여 

NOTE. 페이지를페이지를페이지를페이지를 삭제할삭제할삭제할삭제할

사용자가사용자가사용자가사용자가 페이지에페이지에페이지에페이지에 대한대한대한대한

  

 

페이지의페이지의페이지의페이지의 특정특정특정특정 버전을버전을버전을버전을 삭제삭제삭제삭제 

페이지의 특정 버전을 삭제하고

페이지 특정 버전 삭제를 위해서는

1. 페이지로 이동하여 

2. 삭제하고자 하는 특정

해당 버전이 삭제되면 다른 버전을

경우 기존의 버전 3가 다시 버전

하위 페이지들을 가진 상위 페이지를

됩니다. 하위 페이지들이 삭제되지

만약 하위 페이지들이 다른 상위

상위 페이지를 삭제하는 방법을

 

페이지페이지페이지페이지 복구복구복구복구 

페이지를 복구하기 위해서 다음과

1. 스페이스를 선택 후 

2. Contents Tools > Trash

3. 복구를 원하는 페이지에

만약 Documentation Theme
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 > Delete 를 선택합니다.(페이지 삭제 확인 화면이 나타나면

삭제할삭제할삭제할삭제할 권한이권한이권한이권한이 없다면없다면없다면없다면 해당해당해당해당 권한을권한을권한을권한을 관리자로부터관리자로부터관리자로부터관리자로부터 부여받아야부여받아야부여받아야부여받아야 합니다합니다합니다합니다

대한대한대한대한 권한을권한을권한을권한을 지정하여지정하여지정하여지정하여 놓았다면놓았다면놓았다면놓았다면 페이지를페이지를페이지를페이지를 삭제하지삭제하지삭제하지삭제하지 못할못할못할못할 수수수수 있습니다있습니다있습니다있습니다

삭제하고 싶은 경우 사용자는 스페이스 관리자여야 하는 제약조건이 

위해서는 다음과 같은 절차를 따릅니다. 

 > Page History 로 이동합니다. 

특정 버전 옆의 Delete 를 선택합니다.  

버전을 필요에 따라 자동으로 다시 넘버링이 진행됩니다. 예를 들어

버전 2로 조정됩니다. 

페이지를 삭제하는 경우, 하위의 페이지들은 자동으로 스페이스의

삭제되지 않지만 삭제된 페이지와의 부모-자식 관계를 자동을 없어지게

상위 페이지하에서 유지되기를 원하는 경우 먼저 해당 페이지들을

방법을 사용하면 됩니다. 

다음과 같은 절차를 수행하면 됩니다. 

 하단 사이드바의 Space tools > Content Tools 를 선택합니다

Contents Tools > Trash 를 선택하면 스페이스 내의 삭제된 페이지가 표시됩니다

페이지에 대해 Restore를 선택합니다. 

Documentation Theme를 사용하는 스페이스의 경우  

 

나타나면 진행합니다.) 

합니다합니다합니다합니다. 만약만약만약만약 

있습니다있습니다있습니다있습니다.

 있습니다.  

들어 버전 2를 삭제한 

스페이스의 루트로 이동하게 

없어지게 됩니다. 

페이지들을 이동시킨 후 기존의 

선택합니다. 

표시됩니다. 
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1. 상단의 Browse > Space Admin

2. 스페이스 관리자 옵션에서

나타납니다. 

3. 복구하고자 하는 페이지의

페이지 복구 이후 페이지를 찾기

 

페이지페이지페이지페이지 영구영구영구영구 삭제삭제삭제삭제 

페이지를 완전히 삭제 하기 위해서는

모든 첨부파일, 모든 버전이 모두

페이지를 완전히 삭제하기 위해서는

1. 스페이스로 이동하여

2. Trash를 선택하면, 

3. 특정 페이지를 삭제하는

만약 스페이스가 Documentation theme

1. 상단의 Browse > Space Admin

2. 스페이스 관리자 옵션의

3. 특정 페이지를 삭제하는

 

4.6 레이블레이블레이블레이블 추가추가추가추가, 삭제삭제삭제삭제 및및및및 검색검색검색검색

페이지, 블로그, 첨부파일을 추가할

레이블을 정의하고 그것을 사용함으로써

예를 들어 계정 관련된 페이지에

스페이스나 사이트에 대해 해당
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Browse > Space Admin을 선택합니다. 

옵션에서 Trash를 선택하면 스페이스에서 삭제한 페이지와 블로그

페이지의 Restore 를 선택합니다. 

찾기 위해서 스페이스의 루트로 이동한 후 Pages를 선택합니다

위해서는 휴지통을 비우는 작업이 필요합니다. 이 작업을 사용하면

모두 삭제되게 됩니다. 

위해서는 스페이스 관리자 권한이 필요합니다. 

이동하여 사이드바 하단의 Space tools > Content Tools를 선택합니다

, 삭제된 페이지들과 블로그 포스트들이 나타납니다. 

삭제하는 경우 Purge 버튼을 누르고 전체 삭제를 원하는 경우 Purge All

Documentation theme을 사용하는 경우에는 아래와 같이 진행합니다

Browse > Space Admin을 선택합니다. 

옵션의 Trash를 선택합니다. 

삭제하는 경우 Purge 버튼을 누르고 전체 삭제를 원하는 경우 Purge All

검색검색검색검색 

추가할 때 태그 또는 키워드를 지정할 수 있는 레이블(label)이

사용함으로써 콘텐츠에 대해 카테고리, 식별자, 북마크를 지정할

페이지에 ‘accounting’이란 레이블을 할당하는 경우 레이블 기반의

해당 레이블을 사용하는 페이지를 조회하는 것이 가능합니다.  

 

블로그 포스트 목록이 

선택합니다.  

사용하면 페이지에 포함된 

선택합니다. 

Purge All을 선택합니다.  

진행합니다. 

Purge All을 선택합니다 

이 존재합니다. 자신만의 

지정할 수 있습니다.  

기반의 검색을 통해 모든 
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레이블을 적용하기 위해서는 다음과

1. 키보드 단축키인 L 버턴을

2. 새로운 레이블을 입력한

 

레이블을레이블을레이블을레이블을 통해통해통해통해 검색하기검색하기검색하기검색하기 

특정한 레이블을 가진 콘텐츠를

예를 들어 페이지에 chocolate

‘labelText:chocolate

 

4.7 페이지페이지페이지페이지 제한제한제한제한 걸기걸기걸기걸기 

페이지 제한은 스페이스의 각 페이지들에

페이지가 다른 누군가에게 보여지기

추가하거나 제거하고자 하는 경우

 

페이지페이지페이지페이지 제한제한제한제한 걸기걸기걸기걸기 

페이지에 보기 또는 수정 권한을

1. 페이지로 이동하여 

2. Restrict viewing of this page 
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다음과 같은 절차를 수행합니다. 

버턴을 클릭하거나 페이지에서 버튼을 선택합니다. 

입력한 후 Add를 누릅니다. 

콘텐츠를 검색하기 위해 검색어 키워드 앞에 'labelText:'    를 

chocolate이라는 레이블로 입력된 페이지를 검색하는 경우 상단의 검색

labelText:chocolate’라고 입력하면 됩니다.  

페이지들에 대해 보기/수정 권한을 사용자에게 줄 수 있습니다

보여지기 원치 않는 경우 손쉽게 잠금을 사용할 수 있습니다. 페이지에

경우 페이지에 대한 수정 권한을 가지고 있어야 합니다.  

권한을 걸기 위해 아래와 절차를 수행합니다. 

 > Restrictions 를 선택합니다. 

Restrict viewing of this page 또는 Restrict editing of this page를 선택합니다

 

 

 사용할 수 있습니다. 

검색 필드에 

있습니다. 만약 생성하는 

페이지에 대한 제한을 

선택합니다. 
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3. 사용자나 그룹 이름을

페이지에 제한이 걸리게 된 상태에서

잠겨있다는 메시지를 보게 됩니다

 

현재현재현재현재 페이지의페이지의페이지의페이지의 제한제한제한제한 사항사항사항사항 보기보기보기보기 

현재 페이지에 보기, 수정 제한이

사항을 보기 위해서 페이지로 이동하여

•  > Restrictions

• 위치 경로의 잠금 아이콘

• 에디터 모드에 있는 

 

 

페이지 제한을 해제하기 위해서는
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이름을 선택하고 드롭다운 메뉴에 자동완성되는 적절한 이름을 선택합니다

상태에서 사용자나 그룹이 페이지를 보거나 수정을 시도하는 경우

됩니다.  

 

제한이 걸려 있는데 확인은 페이지의 아이콘을 통해 확인이 가능합니다

이동하여 다음의 절차를 수행합니다. 

> Restrictions를 선택합니다. 

아이콘 을 선택합니다.  

 경우 페이지 상단의 Restricted 아이콘을 클릭합니다. 

위해서는 사용자, 그룹에 지정된 Remove Restriction을 클릭하면

 

선택합니다.  

경우 해당 페이지가 

가능합니다. 페이지의 제한된 

클릭하면 됩니다. 
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4.8 템플릿템플릿템플릿템플릿 사용하기사용하기사용하기사용하기 

새로운 페이지를 추가할 때 scratch

만들 수 있습니다. 템플릿은 컨플루언스

블루프린트나 애드온들에 의해 

템플릿을템플릿을템플릿을템플릿을 유용하게유용하게유용하게유용하게 사용할사용할사용할사용할 수수수수 있는있는있는있는

• 유스케이스를 위한 템플릿을

• 시스템 관리자 스페이스가

 

글로벌글로벌글로벌글로벌 템플릿과템플릿과템플릿과템플릿과 스페이스스페이스스페이스스페이스 템플릿템플릿템플릿템플릿

컨플루언스엔 두 종류의 페이지

• Space templates: 

스페이스 관리자 권한을

• Global templates: 

만약 본인이 스페이스

정의할 수 있습니다. 

또한 시스템 관리자들은 마켓플레이스에서

참조하세요) 

https://confluence.atlassian.com/display/CONF58/Importing+Temp

 

템플릿템플릿템플릿템플릿 생성생성생성생성 

컨플루언스 에디터를 통해 템플릿을

필드를 포함하는 등 페이지에 특별한

 

템플릿템플릿템플릿템플릿 사용사용사용사용 
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scratch로부터 콘텐츠를 쓸 필요는 없으며, 대신 템플릿을 기본으로

컨플루언스 페이지로써 이미 정의된 콘텐츠가 담겨있습니다. 몇몇

 제공되며, 다른 것들은 컨플루언스 사용자에 의해 정의되게 

있는있는있는있는 예예예예. 

템플릿을 소프트웨어 개발 프로젝트에서 가지고 있을 경우 

스페이스가 각 서버가 어떤 정보를 가지고 있어야 할지 정의할 템플

템플릿템플릿템플릿템플릿 

페이지 템플릿이 있습니다.  

Space templates: 이 페이지 템플릿들은 특정 스페이스에서만 사용 가능합니다

권한을 가지고 있다면, 스페이스 관리자 스크린에서 템플릿을 정의할

Global templates: 이 페이지 템플릿들은 컨플루언스 사이트의 모든 스페이스에서

스페이스 컨플루언스 관리자 권한을 가지고 있다면, 컨플루언스 관리자

.  

마켓플레이스에서 미리 정의된 템플릿들을 다운로드 받을 수 있습니다

https://confluence.atlassian.com/display/CONF58/Importing+Templates 

템플릿을 작성할 수 있습니다. 또한 저자가 해당 페이지 작성을 완료하였을

특별한 변수들을 추가할 수 있습니다.  

 

기본으로 새로운 페이지를 

몇몇 템플릿들은 

 됩니다.  

 

템플릿을 가지고 있을 경우 

가능합니다. 만약 본인이 

정의할 수 있습니다.  

스페이스에서 사용 가능합니다. 

관리자 콘솔에서 템플릿을 

있습니다. (다음 링크를 

완료하였을 때 특정 
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페이지 템플릿들은 페이지를 추가할

불가능합니다. 템플릿을 통해 페이지가

플러그인들은 템플릿의 기능을 

찾아볼 수 있습니다.  

 

블루프린트가블루프린트가블루프린트가블루프린트가 제공하는제공하는제공하는제공하는 템플릿템플릿템플릿템플릿 

블루프린트는 기능성이 추가된 

것을 돕기 위해 제공됩니다.  

컨플루언스는 몇 가지 미리 정의된

플레이스에서 다운로드 가능합니다

블루프린트들을 비활성화하거나

 

다이얼로그다이얼로그다이얼로그다이얼로그 생성에서생성에서생성에서생성에서 템플릿템플릿템플릿템플릿 홍보하기홍보하기홍보하기홍보하기

만약 본인이 스페이스 관리자라면

우선적으로 보이도록 선택할 수

특정 타입의 콘텐츠를 사용하여

홍보되는 템플릿 또는 블루프린트들은

타입들의 경우 전부 다음 그림과

link를 클릭합니다.  
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추가할 때만 사용됩니다. 이미 존재하는 페이지에 템플릿을 추가하는

페이지가 만들어질 경우, 템플릿은 더 이상 해당 페이지와 링크되지

 좋게 만들도록 제공하기도 하며, 아틀라시안 마켓플레이스에서

 

 하나의 페이지 템플릿으로써 컨플루언스가 사용자의 콘텐츠

정의된 블루프린트를 가지고 있으며, 추가적인 블루프린트들은 

가능합니다. 또한 개인적인 취향에 맞게 블루프린트를 커스터마이징

비활성화하거나, 개인만의 블루프린트를 개발할 수도 있습니다.  

홍보하기홍보하기홍보하기홍보하기 

관리자라면, 다이얼로그를 만들 때(Create버튼 클릭) 특정 템플릿이나

수 있습니다. 특정 템플릿을 홍보함으로써 사용자들이 빈 페이지

사용하여 일관성을 확보하는데 도움이 됩니다.  

블루프린트들은 가장 위쪽에 나타나며, 빈 페이지나 블로그 포스트를

그림과 같이 아래쪽에 숨겨지게 됩니다. 이 숨겨진 타입들을 보기 

 

추가하는 것은 

링크되지 않습니다. 몇몇 

마켓플레이스에서 템플릿 애드온들을 

콘텐츠 생성, 관리 및 조직하는 

 아틀라시안 마켓 

커스터마이징 할 수 있으며, 특정 

템플릿이나 블루프린트가 

페이지 등을 사용하기보다 

포스트를 포함한 다른 콘텐츠 

 위해선 Show more 
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템플릿이나템플릿이나템플릿이나템플릿이나 블루프린트블루프린트블루프린트블루프린트 홍보하기홍보하기홍보하기홍보하기

1. Space Tools 에서

Browse > Space Admin > Templates 

2. 다이얼로그 생성 시 

템플릿이나 블루프린트를 홍보할

link 아래로 숨겨지게 되는 것을

만약 한 스페이스에서 Show more link

모든 템플릿들을 보여주게 됩니다

 

시스템시스템시스템시스템 템플릿템플릿템플릿템플릿 

컨플루언스는 사이트의 welcome

제공합니다.  

 

템플릿템플릿템플릿템플릿 생성생성생성생성 

컨플루언스엔 두 종류의 페이지

• Space templates: 

스페이스 관리자 권한을

• Global templates: 

만약 본인이 스페이스

정의할 수 있습니다. 

 

스페이스스페이스스페이스스페이스 템플릿템플릿템플릿템플릿 추가추가추가추가 

1. 스페이스로 이동하여

선택합니다. 
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홍보하기홍보하기홍보하기홍보하기 

에서 Content Tools를 선택합니다. 만약 스페이스가 문서의 

Browse > Space Admin > Templates 순서로 선택합니다. 

 보여주고 싶은 템플릿이나 블루프린트들 옆의 Promote를

홍보할 시 빈 페이지나 블로그 포스트들을 포함한 다른 아이템들은

것을 기억하세요.  

Show more link를 통해 세 번 이상 다이얼로그를 만들게 된다면, 

됩니다.  

welcome메시지나 기본 스페이스 콘텐츠 등을 포함하는 ‘system templates

페이지 템플릿이 있습니다.  

Space templates: 이 페이지 템플릿들은 특정 스페이스에서만 사용 가능합니다

권한을 가지고 있다면, 스페이스 관리자 스크린에서 템플릿을 정의할

Global templates: 이 페이지 템플릿들은 컨플루언스 사이트의 모든 스페이스에서

스페이스 컨플루언스 관리자 권한을 가지고 있다면, 컨플루언스 관리자

.  

이동하여 Space Tools를 선택합니다. 이후 사이드바의 하단에서 

 

 주제로 사용중이라면, 

를 선택합니다.  

아이템들은 전부 Show more 

, 그 이후로는 자동적으로 

system templates’를 

가능합니다. 만약 본인이 

정의할 수 있습니다.  

스페이스에서 사용 가능합니다. 

관리자 콘솔에서 템플릿을 

 Content Tools를 
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2. Templates를 선택한

만약 스페이스가 문서의 테마로

1. Browse를 선택한 

NOTE. Space Admin

administrators’

2. Space administration 

3. Create new template

 

글로벌글로벌글로벌글로벌 템플릿템플릿템플릿템플릿 추가추가추가추가 

1. 다음의 설정 아이콘을

Configuration을 

2. 좌측 핸드패널의 Global

3. Add New Global Tempate

 

템플릿템플릿템플릿템플릿 에디터에디터에디터에디터 

템플릿을 만들거나 수정할 때, 일반적으로

됩니다. 다만 추가적으로 다른 사용자가

제공하는 등의 변수를 추가하거나

 

이미지이미지이미지이미지, 테이블테이블테이블테이블, 텍스트와텍스트와텍스트와텍스트와 변수에변수에변수에변수에
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선택한 뒤 Create new template를 선택합니다.  

테마로 쓰이고 있다면, 다음과 같이 사용할 수 있습니다. 

 뒤 상단의 Space Admin을 선택합니다.  

NOTE. Space Admin 옵션은옵션은옵션은옵션은 본인이본인이본인이본인이 스페이스스페이스스페이스스페이스 관리자관리자관리자관리자 권한이권한이권한이권한이 있거나있거나있거나있거나, ‘confluence

’그룹에그룹에그룹에그룹에 포함되어포함되어포함되어포함되어 있을있을있을있을 때만때만때만때만 보여집니다보여집니다보여집니다보여집니다. 

pace administration 옵션에서  Templates를 선택합니다. 

Create new template를 선택합니다.  

아이콘을 클릭한 뒤 , Confluence Administration 아래에 

 선택합니다. 

Global Templates and Blueprints를 선택합니다. 

Add New Global Tempate를 선택합니다. 

일반적으로 페이지나 블로그 포스트를 수정할 때와 같은 방법으로

사용자가 템플릿을 기반으로 페이지를 추가할 시 데이터 수집을

추가하거나 할 수 있습니다.  

변수에변수에변수에변수에 대한대한대한대한 템플릿템플릿템플릿템플릿 에디터에디터에디터에디터 예시예시예시예시 

 

confluence-

 있는 General 

방법으로 에디터를 사용하게 

수집을 할 수 있는 양식을 
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템플릿템플릿템플릿템플릿 베이스로베이스로베이스로베이스로 페이지를페이지를페이지를페이지를 생성생성생성생성 
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 시시시시 화면화면화면화면 예시예시예시예시 
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템플릿템플릿템플릿템플릿 변수변수변수변수 

템플릿에 변수를 추가할 때, 해당

필드에 대해 텍스트 입력 박스를

같은 템플릿 안에서 같은 변수를

때 유용합니다.  

템플릿에템플릿에템플릿에템플릿에 변수변수변수변수 추가하기추가하기추가하기추가하기 

1. Template 를 선택한

위해서 이미 존재하는

2. 변수의 이름을 입력합니다

3. Enter를 누릅니다. (

변수 타입을 변경하기 위해선, 변수의

다음과 같습니다: Text, Multi-

Multi-line Text 필드의 경우 여러

아이템들을 하나씩 입력할 수 있습니다

Hint. $와와와와 변수변수변수변수 이름을이름을이름을이름을

보여주며보여주며보여주며보여주며, 추가할추가할추가할추가할 수수수수
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해당 변수들은 필드 양식으로 동작합니다. 즉, 템플릿 베이스로

박스를 볼 수 있습니다. 필드에 데이터를 넣고 그 후 페이지를 추가합니다

변수를 한 번 이상 사용할 수 있으며, 이는 한 페이지에서 같은 정보가

선택한 뒤, 에디터 툴바에서 New Variable을 선택합니다. (또는

존재하는 변수를 선택합니다) 

입력합니다. 

. (기본적으로 이 동작은 단순한 한 줄의 입력 필드를 생성합니다

변수의 플레이스홀더를 클릭한 뒤, 나타나는 변수 속성 패널을

-line Text, List 

여러 줄의 라인을 사용할 수 있으며, List의 경우 콤마로 분리되어

있습니다.  

이름을이름을이름을이름을 입력하고입력하고입력하고입력하고 Enter 를를를를 누를누를누를누를 시시시시 기존에기존에기존에기존에 존재하는존재하는존재하는존재하는 추천하는추천하는추천하는추천하는 변수변수변수변수

수수수수 있습니다있습니다있습니다있습니다.  

 

베이스로 페이지를 생성 시 각 

추가합니다.  

정보가 한 번 이상 필요할 

또는 페이지에 추가하기 

생성합니다) 

패널을 선택합니다. 타입은 

분리되어 리스트에 있는 

 

 

변수변수변수변수 목록을목록을목록을목록을 
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레이블레이블레이블레이블 

만약, 이 템플릿을 이용하여 만들어진

생성 시 최상단의 레이블 아이콘

 

이미지와이미지와이미지와이미지와 다른다른다른다른 첨부파일들첨부파일들첨부파일들첨부파일들 

템플릿에 이미지나 다른 첨부파일들을

body부분에 삽입할 수는 있습니다

다음은 그 예시입니다.  

• 페이지에 이미지를 첨부한

있습니다.  

• 페이지에 PDF를 첨부한

수 있습니다. 

 

교육용교육용교육용교육용 텍스트텍스트텍스트텍스트 

교육용 텍스트는 템플릿에 있는

템플릿을 사용하여 페이지를 만드는

교육용교육용교육용교육용 텍스트텍스트텍스트텍스트 추가하기추가하기추가하기추가하기 

1. 툴바에서 Template > Instrctional Text

2. 교육용 텍스트를 작성합니다

교육용 텍스트는 음영진 배경과

또한, Text에서도 플레이스홀더

• User mention – 사용자
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만들어진 모든 템플릿들이 하나 또는 그 이상의 레이블들을 가지길

아이콘 을 선택합니다.  

첨부파일들을 첨부할 수는 없습니다. 대신, 다른 페이지에 해당 파일을

있습니다.  

첨부한 뒤, Insert > Files and Images를 선택하여 템플릿에

첨부한 뒤, Insert > Other Macros > PDF를 선택하여 템플릿에

있는 플레이스홀더 콘텐츠이며, 오직 페이지를 수정할 경우에만 

만드는 사용자들의 안내용으로 사용하십시오.  

Template > Instrctional Text를 선택합니다.  

작성합니다. (예로, 여기에 인터페이스의 이미지를 넣으세요 등

배경과 이탤릭체로 보이게 되어 일반 텍스트와 구별되게 됩니다.  

플레이스홀더 타입을 변경할 수 있습니다. 

사용자 멘션 다이얼로그를 엽니다. 

 

가지길 원한다면, 페이지 

파일을 첨부하여, 템플릿의 

템플릿에 이미지를 첨부할 수 

템플릿에 PDF를 첨부할 

 보여집니다. 이 기능을 

등) 
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• JIRA Macro – 다이얼로그를

이슈들을 페이지에 포함할

 

템플릿에템플릿에템플릿에템플릿에 세부설명세부설명세부설명세부설명 추가추가추가추가하기하기하기하기 

템플릿 세부설명은 ‘Create’ 다이얼로그에서

설명하는데 있어서 유용합니다. 

 

템플릿에템플릿에템플릿에템플릿에 세부설명세부설명세부설명세부설명 추가방법추가방법추가방법추가방법 

• 스페이스나 글로벌 템플릿

• ‘Description’ 칼럼의

• 세부설명을 입력한 뒤

 

템플릿템플릿템플릿템플릿 수정수정수정수정 또는또는또는또는 삭제삭제삭제삭제 

만약 템플릿에서 어떤 내용이든

이동하여, Edit 또는 Delete를

NOTE.  

� 페이지페이지페이지페이지 템플릿들은템플릿들은템플릿들은템플릿들은

템플릿을템플릿을템플릿을템플릿을 추가하는추가하는추가하는추가하는

템플릿은템플릿은템플릿은템플릿은 더더더더
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다이얼로그를 열어 JIRA 이슈를 생성하도록 하거나, 하나 또는

포함할 수 있게 합니다. 

다이얼로그에서 보여지며, 다른 사용자들에게 해당 템플릿이 

.  

템플릿 페이지로 이동합니다. (아래와 묘사된 바와 같이)  

칼럼의 Edit 아이콘을 선택합니다. 

뒤 Save를 선택합니다. 

내용이든 수정이 필요하거나, 템플릿을 지우고 싶을 경우 스페이스나

를 선택합니다.  

템플릿들은템플릿들은템플릿들은템플릿들은 페이지를페이지를페이지를페이지를 추가할추가할추가할추가할 때만때만때만때만 사용됩니다사용됩니다사용됩니다사용됩니다. 이미이미이미이미 존재하는존재하는존재하는존재하는 페이지에페이지에페이지에페이지에

추가하는추가하는추가하는추가하는 것은것은것은것은 불가능합니다불가능합니다불가능합니다불가능합니다. 템플릿을템플릿을템플릿을템플릿을 통해통해통해통해 페이지가페이지가페이지가페이지가 만들어질만들어질만들어질만들어질

더더더더 이상이상이상이상 해당해당해당해당 페이지와페이지와페이지와페이지와 링크되지링크되지링크되지링크되지 않습니다않습니다않습니다않습니다. 몇몇몇몇몇몇몇몇 플러그인들은플러그인들은플러그인들은플러그인들은 

 

또는 그 이상의 JIRA 

 어떤 용도인지 

 

스페이스나 글로벌 템플릿으로 

페이지에페이지에페이지에페이지에 

만들어질만들어질만들어질만들어질 경우경우경우경우, 

플러그인들은플러그인들은플러그인들은플러그인들은 템플릿의템플릿의템플릿의템플릿의 
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기능을기능을기능을기능을 좋게좋게좋게좋게

애드온들을애드온들을애드온들을애드온들을

� 만약만약만약만약 템플릿에서템플릿에서템플릿에서템플릿에서

preview

정상적으로정상적으로정상적으로정상적으로

� 템플릿템플릿템플릿템플릿 에디터는에디터는에디터는에디터는

� 컨플루언스는컨플루언스는컨플루언스는컨플루언스는

‘‘‘‘system templates

 

템플릿을템플릿을템플릿을템플릿을 사용하여사용하여사용하여사용하여 페이지페이지페이지페이지 생성생성생성생성 

글로벌 템플릿(모든 스페이스에서

만들 수 있습니다. 이 페이지를 

확인하세요.  

 

템플릿으로부터템플릿으로부터템플릿으로부터템플릿으로부터 페이지로페이지로페이지로페이지로 정보정보정보정보 복사복사복사복사

템플릿을 통해 페이지를 만들 경우

• 레이블 

• 텍스트와 스타일 

• 레이아웃과 포맷팅 

• 매크로 

• 임베디드된 이미지들과

 

템플릿으로부터템플릿으로부터템플릿으로부터템플릿으로부터 보여지는보여지는보여지는보여지는 필드필드필드필드 양식양식양식양식
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좋게좋게좋게좋게 만들도록만들도록만들도록만들도록 제공하기도제공하기도제공하기도제공하기도 하며하며하며하며, 아틀라시안아틀라시안아틀라시안아틀라시안 마켓플레이스에서마켓플레이스에서마켓플레이스에서마켓플레이스에서 템플릿템플릿템플릿템플릿

애드온들을애드온들을애드온들을애드온들을 찾아볼찾아볼찾아볼찾아볼 수수수수 있습니다있습니다있습니다있습니다.  

템플릿에서템플릿에서템플릿에서템플릿에서 Table of Contents macro 를를를를 사용하는사용하는사용하는사용하는 경우경우경우경우, 

preview 에선에선에선에선 에러가에러가에러가에러가 날날날날 수도수도수도수도 있으나있으나있으나있으나, 실제실제실제실제 사용자가사용자가사용자가사용자가 템플릿을템플릿을템플릿을템플릿을 이용해이용해이용해이용해 

정상적으로정상적으로정상적으로정상적으로 작동합니다작동합니다작동합니다작동합니다.   

에디터는에디터는에디터는에디터는 오직오직오직오직 컨플루언스컨플루언스컨플루언스컨플루언스 4.3 이나이나이나이나 그그그그 이후이후이후이후 버전에서만버전에서만버전에서만버전에서만 가능합니다가능합니다가능합니다가능합니다

컨플루언스는컨플루언스는컨플루언스는컨플루언스는 사이트의사이트의사이트의사이트의 welcome 메시지나메시지나메시지나메시지나 기본기본기본기본 스페이스스페이스스페이스스페이스 콘텐츠콘텐츠콘텐츠콘텐츠 등을등을등을등을

system templates’’’’를를를를 제공합니다제공합니다제공합니다제공합니다.   

 

스페이스에서 사용가능)이나, 스페이스 템플릿(해당 스페이스에서만 사용가능

 읽기 전에 본인의 컨플루언스 사이트에 누군가가 템플릿을 만들어두었는지

복사복사복사복사 

경우, 컨플루언스는 다음 콘텐츠와 정보들을 템플릿에서 새 페이지로

 

이미지들과 기타 파일들 

양식양식양식양식 

 

템플릿템플릿템플릿템플릿 

이용해이용해이용해이용해 만들만들만들만들 경우경우경우경우 

가능합니다가능합니다가능합니다가능합니다.  

등을등을등을등을 포함하는포함하는포함하는포함하는 

사용가능)을 통해 페이지를 

만들어두었는지 

페이지로 복사합니다.  
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만든이가 템플릿에 변수들을 포함해두었다면

제공할 것입니다.  

 

템플릿으로템플릿으로템플릿으로템플릿으로 페이지페이지페이지페이지 생성방법생성방법생성방법생성방법 

1. 헤더에서 Create를

2. 사용하고자 하는 space

3. 만약 해당 템플릿이 

작성한 뒤, Next를

4. 이제 템플릿에 기반한

정보들을 포함하게 될

5. 페이지의 이름을 작성합니다

6. 다른 콘텐츠를 추가하거나

7. Save를 선택합니다

 

템플릿을템플릿을템플릿을템플릿을 통해통해통해통해 페이지페이지페이지페이지 생성생성생성생성 시시시시 보여지는보여지는보여지는보여지는
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포함해두었다면, 컨플루언스는 사용자가 페이지를 생성 시 변수들에

를 선택합니다. 

space와 template을 선택한 뒤, Next를 선택합니다.  

 변수들을 가지고 있다면, 양식이 보일 것입니다. 해당 필드 양식에

를 선택합니다.  

기반한 새 페이지가 보일 것이며, 필드 양식에 정보를 기입하였다면

될 것입니다.  

작성합니다.  

추가하거나 필요할 경우 다른 내용들을 변경합니다. 

선택합니다. 

보여지는보여지는보여지는보여지는 템플릿템플릿템플릿템플릿 변수변수변수변수 예시예시예시예시 

 

변수들에 값을 넣도록 즉시 

양식에 연관된 정보들을 

기입하였다면, 페이지는 해당 
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5 파일파일파일파일 처리처리처리처리(Files) 

팀 협업에 있어 PDF, 오피스 문서

가능합니다. 각 파일들은 자동으로

가능합니다.  

첨부된 파일들은 업로드되어 현재

참조됩니다. 

컨플루언스에서 파일은 다음과 

• 파일 업로드 

• 파일 및 이미지 표시

• 파일 관리 

• 파일을 이용한 협업 

• 오피스 파일 편집 

권한권한권한권한(Permissions) 

스페이스 내의 파일 업로드 및 삭제를

Page’나 ‘Add Blog’권한을 가진

못하는 경우 파일을 업로드하거나

 

5.1 파일파일파일파일 업로드업로드업로드업로드 

이미지나 문서와 같은 파일을 업로드할

위해서는 ‘Add Attachments

파일을 첨부하는 다양한 방법이

• 페이지로 파일을 직접

• Insert > Files and images

현재 보고 있는 페이지에 파일을
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문서, 이미지와 다른 파일 포맷들을 컨플루언스를 통해 업로드하고

자동으로 버저닝이 되며, 미리보기, 문자열 기반 검색, 네트워크 드라이브를

현재 페이지와 블로그 포스트에 포함되며, 이 파일들은 attachments

 같이 사용됩니다. 

표시 

 

삭제를 수행할 수 있는 권한을 사용자에게 할당하는 것이 가능합니다

가진 사용자들은 페이지에 첨부가 가능하지만 ‘Add Attachement

업로드하거나 삭제하지 못합니다.  

업로드할 때 현재의 페이지에서 첨부를 진행하게 될 것입니다

Add Attachments’ 권한이 있어야 하여, 이는 스페이스 관리자를 통해 요청해야

방법이 존재하며, 에디터를 통한 방법은 다음과 같습니다. 

접 드래그하여 옮김 

Insert > Files and images를 선택하고 파일을 업로드 

파일을 첨부하는 방법은 다음과 같습니다. 

 

업로드하고 공유하는 것이 

드라이브를 통한 공유가 

attachments로써 

가능합니다. ‘Add 

Add Attachement’ 권한을 가지지 

것입니다. 파일을 업로드 하기 

요청해야 합니다. 



Confidential 

• 페이지로 파일을 직접

• 페이지 상단의  

또한 한번에 여러 개의 파일을 업로드하는

NOTE. 컨플루언스가컨플루언스가컨플루언스가컨플루언스가

시스템시스템시스템시스템 관리자를관리자를관리자를관리자를 통해통해통해통해 

제한되어제한되어제한되어제한되어 있으므로있으므로있으므로있으므로, 관리자를관리자를관리자를관리자를

 

파일파일파일파일 버전버전버전버전 

동일한 페이지 상의 기존에 존재하는

첨부파일을 덮어쓰게 됩니다. 버전

NOTE. 파일파일파일파일 업로드시업로드시업로드시업로드시

첨부파일에첨부파일에첨부파일에첨부파일에 특수특수특수특수 문자가문자가문자가문자가

발생하게발생하게발생하게발생하게 됩니다됩니다됩니다됩니다. 

 

5.2 파일파일파일파일 및및및및 이미지이미지이미지이미지 표시하기표시하기표시하기표시하기

파일들은 썸네일로써 페이지 상에

업로드하는 파일들의 유형이 따라

이미지이미지이미지이미지 삽입삽입삽입삽입 

페이지에 이미지를 삽입하는 몇

• 에디터 툴바의 Insert > Files and images

선택합니다. 

• 에디터 화면으로 이미지

• ! 를 타이핑하고 자동
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직접 드래그하여 옮김 

 > Attachments를 선택하여 파일을 업로드 

업로드하는 것이 가능합니다. 

컨플루언스가컨플루언스가컨플루언스가컨플루언스가 모든모든모든모든 파일의파일의파일의파일의 유형을유형을유형을유형을 페이지에페이지에페이지에페이지에 포함시킬포함시킬포함시킬포함시킬 수수수수 있으나있으나있으나있으나, 최대최대최대최대 파일의파일의파일의파일의

통해통해통해통해 조정해야조정해야조정해야조정해야 합니다합니다합니다합니다. 기본기본기본기본 업로드업로드업로드업로드 파일파일파일파일 사이트사이트사이트사이트 최대최대최대최대 크기는크기는크기는크기는 10MB

관리자를관리자를관리자를관리자를 통해통해통해통해 이이이이 값을값을값을값을 증가시켜야증가시켜야증가시켜야증가시켜야 합니다합니다합니다합니다. 

존재하는 첨부파일과 같은 이름의 파일을 업로드하는 경우, 컨플루언스는

버전 히스토리는 모든 첨부파일들에 대한 이를 기록합니다.  

업로드시업로드시업로드시업로드시 첨부파일이첨부파일이첨부파일이첨부파일이 특수특수특수특수 문자가문자가문자가문자가 입력되지입력되지입력되지입력되지 않도록않도록않도록않도록 주의하도록주의하도록주의하도록주의하도록 합니다합니다합니다합니다

문자가문자가문자가문자가 포함되는포함되는포함되는포함되는 경우경우경우경우 예상치예상치예상치예상치 못한못한못한못한 에러나에러나에러나에러나 검색에검색에검색에검색에 의해의해의해의해 찾을찾을찾을찾을 수수수수 없는없는없는없는

표시하기표시하기표시하기표시하기 

상에 표시되며, 매크로를 사용하여 내부적으로 표시되거나 링크가

따라 표시되는 방식이 달라지게 됩니다. 

몇 가지 방법이 존재합니다. 

Insert > Files and images를 선택한 후 파일을 업로드하거나

이미지 파일을 직접 드래그하여 입력합니다. 

자동 드롭다운 메뉴를 활용하여 첨부된 이미지를 선택합니다. 

 

파일의파일의파일의파일의 크기는크기는크기는크기는 

10MB 로로로로 

컨플루언스는 기존의 

 

합니다합니다합니다합니다. 페이지나페이지나페이지나페이지나 

없는없는없는없는 상황이상황이상황이상황이 

링크가 걸리게 됩니다. 

업로드하거나 기존에 있는 파일들을 
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동일한동일한동일한동일한 컨플루언스컨플루언스컨플루언스컨플루언스 사이트의사이트의사이트의사이트의 다른다른다른다른

동일한 컨플루언스 사이트의 다른

있어야 합니다.  

다른 페이지에 이미 삽입된 이미지를

1. Insert > Files and images

2. 이미지의 이름을 입력합니다

3. 현재 스페이스 또는 

4. 검색 결과에 나타난 

다른 방법으로 복사는 원하는 다른

수도 있습니다. 

 

이미지를이미지를이미지를이미지를 웹으로부터웹으로부터웹으로부터웹으로부터 삽입삽입삽입삽입 

페이지의 이미지를 인터넷 상의

저장할 필요가 없으며, 단지 해당

웹 페이지 상의 이미지를 표시하기

1. 페이지를 편집하는 도중

2. Insert > Files and Images

3. 해당 이미지에 대한 

4. URL과 이미지가 정확한지

5. Insert를 선택하여 

다른 방법으로 웹 페이지의 해당

 

이미지이미지이미지이미지 표시표시표시표시 변경변경변경변경 
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다른다른다른다른 페이지에페이지에페이지에페이지에 첨부된첨부된첨부된첨부된 이미지를이미지를이미지를이미지를 표시표시표시표시 

다른 페이지에 첨부된 이미지를 표시하기 위해서는 이미지의 이름을

이미지를 첨부하고자 하는 경우에는 다음의 절차를 수행하면 됩니다

Insert > Files and images를 선택한 후 Search on other pages를 선택합니다

입력합니다. 

 All Spaces 검색을 선택한 후 Search를 선택합니다. 

 이미지 중 필요한 이미지를 선택한 후 Insert를 선택합니다

다른 페이지에서 해당 이미지를 복사한 후 페이지에 붙여넣기는

상의 이미지로 넣고 싶은 경우가 있을 수 있습니다. 이 경우 별도로

해당 이미지에 대한 URL만 알고 있으면 됩니다. 

표시하기 위해서 다음의 작업을 수행하면 됩니다. 

도중 이미지를 위치시키고자 하는 곳에 커서를 둡니다. 

Insert > Files and Images를 선택하고, Images from the web을 선택합니다

 URL을 입력합니다. 

정확한지 확인하기 위해 Preview 를 선택하여 확인합니다. 

 이미지를 삽입합니다. 

해당 이미지를 복사/붙여넣기를 하여 입력할 수도 있습니다. 

 

이름을 사전에 알고 

됩니다. 

선택합니다. 

선택합니다. 

붙여넣기는 하는 방법을 사용할 

별도로 해당 이미지를 파일로 

선택합니다. 
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페이지를 편집시 이미지를 선택하게

테두리 입력, 이미지 링크 등의 

프로퍼티 패널에서 조정할 수 있는

• 이미지에 대한 preset size

• 이미지에 대한 가로 

• 이미지 주변의 테두리

• 페이지나 URL에 대한

• 이미지의 정렬 방식 

• 이미지 제목 지정 

• 이미지에 커서를 올렸을

• 그림자, 스냅샷과 같은

 

이미지이미지이미지이미지 삭제삭제삭제삭제 

페이지 상의 이미지를 삭제하는

완전히 삭제하려면  > Attachments

 

이미이미이미이미지와지와지와지와 PDF 미리보기미리보기미리보기미리보기 

Preview를 선택했을 때 페이지의

으로부터 가져온 이미지를 포함하거나

미리보기는 다음의 기능을 수행합니다

• 이미지 파일 다운로드
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선택하게 되면 이미지 프로퍼티 패널이 나타납니다. 이 패널은 이미지의

 작업을 수행할 수 있습니다.  

있는 내용은 다음과 같습니다. 

preset size 

 크기(width) 

테두리 굵기 

대한 링크 걸기 

 

올렸을 때 나타나는 텍스트 

같은 효과 추가 

삭제하는 경우 페이지로 삽입된 첨부파일은 지워지지 않습니다. 이미지를

> Attachments로 이동하여 파일을 선택 후 삭제해야 합니다.   

페이지의 이미지와 PDF 링크를 클릭할 수 있습니다. 미리보기는

포함하거나 페이지에 첨부된 이미지와 PDF 를 보여주게 됩니다

수행합니다. 

다운로드 

 

이미지의 표시 크기, 

이미지를 페이지로부터 

 

미리보기는 페이지 상에 표시된 

됩니다. 
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• 새로운 버전의 파일 

• 파일에 대한 코멘트 

• 줌인, 줌아웃 또는 브라우저

• 페이지에 첨부된 다른

• 전체 화면(프레젠테이션

NOTE. 인터넷 익스플로러 9은

것을 권장합니다. 

 

멀티미디어멀티미디어멀티미디어멀티미디어 파일파일파일파일 표시표시표시표시 

멀티미디어 파일을 멀티미디어 

있습니다. 멀티미디어 파일은 Widget Connector Macro

표시합니다. 

 

오피스오피스오피스오피스 파일과파일과파일과파일과 PDF  

페이지에 파일을 삽입하는 것은

좋은 방법입니다. 

오피스 문서나 PDF 파일들을 

• 링크 사용 – 사용자들은

• 썸네일 사용 – 사용자들은

• 페이지 내에 포함 – 

썸네일이나 링크로써 파일을 표시하기

썸네일로써 페이지 상에 표시되며

PDF, 프리젠테이션, 스프레드

포함시킬 수 있습니다.  
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 업로드 

 추가 

브라우저 크기에 맞는 이미지 리사이징 

다른 파일 보기와 썸네일 선택 

프레젠테이션)모드로 전환 

은 PDF보기의 화질이 나쁠 수 있습니다. 이 경우 해당 PDF

 매크로를 사용하여 페이지에 첨부된 멀티미디어 파일을 표시하는

Widget Connector Macro를 사용하여 YouTube, Vimeo 

것은 문서, 스프레드 시트, 프리젠테이션과 다른 가용한 파일을 효과적으로

 페이지 상에 표시하는 몇 가지 방법은 다음과 같습니다. 

사용자들은 링크를 클릭하여 파일을 다운로드 

사용자들은 썸네일을 사용하여 미리보기를 클릭하거나 파일을 다운로드

 사용자들은 페이지에서 떠나지 않고서 콘텐츠를 볼 수 있음 

표시하기 위해서는 페이지 에디터에서 Insert > Files를 선택합니다

표시되며, 크기를 재조정하거나 링크로 파일을 보여질 수 있도록 설정할

스프레드 시트와 오피스 문서를 페이지에 삽입하는 경우 View File Macro

 

PDF를 다운로드하여 보는 

표시하는 기능을 가지고 

YouTube, Vimeo 비디오 등을 

효과적으로 만드는 가장 

다운로드 

 

선택합니다. 해당 파일은 

설정할 수 있습니다.  

View File Macro를 사용하여 
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에디터를 통해 PDF와 오피스 

 

페이지페이지페이지페이지 상의상의상의상의 첨부된첨부된첨부된첨부된 파일파일파일파일 표시표시표시표시 

페이지 상에 첨부된 파일들의 목록을

• 현재 페이지에 첨부된

• 스페이스 내의 모든 

• 페이지에 첨부된 이미지의

파일 목록을 업로드, 보기, 관리하기

 

5.3 파일파일파일파일 관리관리관리관리 

파일들은 일반적으로 컨플루언스

파일들에 대한 다운로드, 삭제, 

 

파일파일파일파일 다운로드다운로드다운로드다운로드 

페이지에 대해 보기 권한을 가진

각 개별 파일을 다운로드하기 위해서

• 파일 미리보기에서 Download 

오른쪽 마우스를 클릭한

페이지에 저장된 모든 파일들을

• 페이지의  > Attachments 

• Download All 을 

NOTE. 스페이스스페이스스페이스스페이스 내의내의내의내의

않습니다않습니다않습니다않습니다. 
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 파일을 자동으로 업로드하고 페이지로 포함시킬 수 있습니다

 

목록을 보기 위해 몇 가지 방법이 사용됩니다. 

첨부된 파일들을 보기 위한 Attaches Macro 사용 

 파일을 보기 위한 Space Attachment Macro 

이미지의 썸네일을 보기 위한 Gallery Macro 

관리하기 위해 File List blueprint를 사용할 수도 있습니다. 

컨플루언스 페이지에 포함됩니다. 첨부된 파일들에 대한 찾기를 수행할

, 편집을 수행할 수 있습니다.  

가진 모든 사용자는 페이지 첨부된 모든 파일을 다운로드할 수 있습니다

위해서 아래의 작업을 수행합니다. 

Download 버튼을 클릭하거나  > Attachments 로 이동하며

클릭한 후 저장 버튼을 클릭합니다. 

파일들을 zip파일 형태로 다운받기 위해 아래의 작업을 수행합니다. 

> Attachments 로 이동합니다. 

 클릭합니다. 

내의내의내의내의 모든모든모든모든 첨부첨부첨부첨부 파일들을파일들을파일들을파일들을 다운로드다운로드다운로드다운로드 받을받을받을받을 수수수수 있는있는있는있는 방법은방법은방법은방법은 현재현재현재현재 존재하지존재하지존재하지존재하지

 

있습니다.  

 

수행할 수 있으며, 해당 

있습니다.  

이동하며 파일 이름에 

 

존재하지존재하지존재하지존재하지 
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첨부파일첨부파일첨부파일첨부파일 삭제삭제삭제삭제 

첨부된 파일을 삭제하기 위해서는

파일을 삭제하기 위해 아래의 작업을

1. 첨부파일이 포함된 페이지로

2.  > Attachments

3. 삭제하고자 하는 첨부파일

4. 삭제할 것인지 확인하는

삭제된 파일은 휴지통으로부터 

스페이스 관리자는 첨부파일의 

1. 페이지의  > Attachments

2. 첨부된 파일 버전의 

 

첨부파일의첨부파일의첨부파일의첨부파일의 새로운새로운새로운새로운 버전버전버전버전 업로드업로드업로드업로드 

첨부된 파일의 새로운 버전을 업로드하는

• 동일 파일 이름을 가진

• Upload a new version
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위해서는 ‘Delete Attachments’ 권한을 가지고 있어야 합니다. 

작업을 수행합니다. 

페이지로 이동합니다. 

> Attachments로 이동합니다. 

첨부파일 옆의 Delete를 선택합니다. 

확인하는 메시지에 대해 Delete를 선택합니다. 

 다시 복구가 가능하며, 이 작업은 스페이스 관리자 권한을 가지고

 특정 버전에 대한 삭제를 수행할 수 있습니다. 

> Attachments를 선택합니다. 

 목록의 화살표를 선택한 후 삭제하고자 하는 버전의 Delete

 

업로드하는 두 가지 방법이 존재합니다.  

가진 페이지로 파일을 업로드 

Upload a new version버튼을 사용하여 다른 이름을 가진 파일을 업로드 

 

.  

가지고 있어야 합니다.  

Delete를 선택합니다. 
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첨부된 버전을 보기 위해서 다음과

• 페이지의  > Attachments

• 첨부파일 이름 옆의 

 

파일을파일을파일을파일을 다른다른다른다른 페이지로페이지로페이지로페이지로 이동이동이동이동 

파일을 다른 페이지로 이동하기

Attachments’ 권한이 필요합니다

첨부된 파일의 위치를 변경하기

• 페이지의   > Attachments

• 이동하고자 하는 파일

• 이동하고자 하는 파일의

• Save를 눌러 저장합니다

NOTE. 만약만약만약만약 이동하려는이동하려는이동하려는이동하려는

전에전에전에전에 스페이스스페이스스페이스스페이스 키를키를키를키를 입력하여야입력하여야입력하여야입력하여야

 

스페이스스페이스스페이스스페이스 내의내의내의내의 모든모든모든모든 파일파일파일파일 표시표시표시표시 

스페이스 내에 첨부된 모든 파일을

• 페이지의 파일 목록을

• 스페이스로 이동하여

Attachments를 선택

• Documentations 

특정 페이지를 찾고자 하는 경우

기능을 제공합니다. 
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다음과 같은 작업을 수행합니다. 

> Attachments로 이동합니다. 

 확장 화살표 링크를 클릭합니다. 

이동하기 위해서는 해당 사용자의 ‘Add Page’, ‘Add Attachments

필요합니다. 

변경하기 위해 

> Attachments로 이동합니다. 

파일 옆의 Properties 를 선택합니다. 

파일의 대상 페이지 이름을 입력합니다. 

저장합니다. 

이동하려는이동하려는이동하려는이동하려는 파일의파일의파일의파일의 페이지가페이지가페이지가페이지가 다른다른다른다른 스페이스에스페이스에스페이스에스페이스에 있는있는있는있는 경우경우경우경우 페이지페이지페이지페이지 이름을이름을이름을이름을

입력하여야입력하여야입력하여야입력하여야 합니다합니다합니다합니다.  

 

파일을 표시하기 위해 아래와 같이 수행합니다. 

목록을 표시하기 위한 Space Attachments macro를 사용 

이동하여 사이드바 하단의 Space tools > Content Tools를 선택한

선택 

ons 테마를 사용하는 경우 Browse > Space Operations > Attachments

경우 파일 확장자 또는 레이블을 사용하여 특정한 파일들을 필터링하여

 

Add Attachments’, ‘Remove 

이름을이름을이름을이름을 입력하기입력하기입력하기입력하기 

 

선택한 후 

Browse > Space Operations > Attachments를 선택 

필터링하여 볼 수 있는 
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5.4 파일을파일을파일을파일을 이용한이용한이용한이용한 협업협업협업협업 기능기능기능기능

협업은 단지 페이지 상에서만 발생하지

대한 협업도 필요할 수 있습니다

것이 가능합니다.  

 

파일파일파일파일 공유공유공유공유 

페이지 상의 많은 파일이 존재하고

1. 파일을 미리보기 위한

2. Share 버튼을 선택합니다

3. 공유하고자 하는 대상의

선택합니다. 

공유 시 해당 팀원들은 메시지와
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기능기능기능기능 

발생하지 않습니다. 때로 문서, 프레젠테이션 파일, 스프레드 

있습니다. 컨플루언스 파일에 대한 협업을 통해  팀원의 피드백, 동시

존재하고 파일들 중 하나를 팀원과 공유하기 위한 방법이 존재합니다

위한 썸네일 또는 링크를 클릭합니다. 

선택합니다. 

대상의 이메일 주소, 사용자 이름, 그룹 이름을 입력한 후 메시지와

메시지와 파일을 볼 수 있는 링크를 이메일을 통해 받게 됩니다. 

 

 시트, 이미지 파일들에 

동시 작업 등을 수행하는 

존재합니다. 

메시지와 보내기를 
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파일에파일에파일에파일에 코멘트코멘트코멘트코멘트 추가하기추가하기추가하기추가하기 

파일에 대해 피드백을 받아야 하거나

기능이 존재합니다.  

파일에 코멘트를 추가하기 위해서

1. 파일의 미리보기의  

2. 미리보기 하단의 핀 

3. 코멘트를 추가하고 Save

핀 형태의 코멘트를 마치 인라인

링크, 매크로 등을 사용하는 것이

대해 코멘트를 추가하고 답글을

아래 그림은 코멘트를 다는 방법에

NOTE. 웹웹웹웹 서버에서버에서버에서버에 의해의해의해의해

코멘트를코멘트를코멘트를코멘트를 달달달달 수수수수 없습니다없습니다없습니다없습니다
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하거나 작업에 대한 커뮤니케이션을 하는 경우 사용자의 코멘트를

위해서 다음의 작업을 수행합니다. 

  썸네일이나 링크를 클릭합니다. 

 아이콘을 드래그하여, 코멘트해야 할 위치에 드롭합니다. 

Save를 합니다. 

인라인 코멘트를 단 것과 같이 작동합니다. 코멘트 시 사용자를 지정하는

것이 가능합니다.  페이지에 대한 코멘트 추가 권한을 가진 모든

답글을 다는 것이 가능합니다. 

방법에 대한 설명을 보여주는 그림입니다.  

의해의해의해의해 호스팅되는호스팅되는호스팅되는호스팅되는 파일이나파일이나파일이나파일이나 URL 을을을을 사용하여사용하여사용하여사용하여 입력된입력된입력된입력된 이미지의이미지의이미지의이미지의 

없습니다없습니다없습니다없습니다.  

 

코멘트를 추가할 수 있는 

지정하는 @mentions와 

모든 사용자는 해당 파일에 

 

 경우경우경우경우 
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5.5 오피스오피스오피스오피스 파일파일파일파일 편집편집편집편집 

Office Connector는 첨부된

수 있어 파일을 다운로드하고 재업로드를

Office Connector는 특정 브라우저에서만

사전에 확인하여야 합니다. 

 

첨부된첨부된첨부된첨부된 문서에문서에문서에문서에 대한대한대한대한 편집편집편집편집 

페이지 내에 첨부된 오피스 문서를

1. 페이지의  > Attachments

2. 편집하고자 하는 첨부문서

묻게 됩니다. 

3. OK를 선택합니다. OK

메시지를 볼 수 있으며

4. 오피스 애플리케이션

저장됩니다. 

 

Office Connector  사전사전사전사전 요구사항요구사항요구사항요구사항
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첨부된 오피스 문서를 편집할 수 있는 강력한 기능을 제공하며, 편집된

재업로드를 해야 하는 번거로움을 없애줍니다. 

브라우저에서만 제한적으로 사용이 가능하니 이는 Atlassian 

문서를 편집하기 위해서는 다음의 작업 절차를 수행합니다. 

> Attachments로 이동합니다. 

첨부문서 측면의 Edit in Office를 선택합니다. 브라우저는 해당

. OK를 선택하는 경우 컨플루언스 서버에 로그인을 할 것인지

있으며, 로그인을 묻는 경우 username과 password를 입력한

애플리케이션 내의파일이 열리게 되며, 파일을 변경 후 저장하게 되면 컨플루언스에

요구사항요구사항요구사항요구사항 

 

편집된 파일을 즉시 저장할 

Atlassian 웹 사이트를 통해 

해당 파일을 오픈할 것인지 

것인지 묻거나 보안 경고 

입력한 후 OK를 누릅니다. 

컨플루언스에 다시 

 



Confidential 

문서, 스프레드 시트, 프리젠테이션

Connector가 해당 문서들을 

오피스 문서와 PDF 파일들은 

마이크로소프트 오피스 97~2013

• .doc, .docx 

• .xls, .xlsx 

• .ppt, .ppts 

• .pdf 

오피스 파일을 편집하기 위해 사용자의

컨플루언스에 의해 해당 오피스
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프리젠테이션 파일에 대한 공유와 협업을 팀 내에서 하는 것이 가능합니다

 embed, import, edit할 수 있도록 제공하고 있습니다. 

 View File macro를 사용하여 페이지 내에 포함되어 보여집니다

97~2013버전, PDF 파일과 호환성을 가지고 있으며, 다음의 확장자를

사용자의 컴퓨터 상에 별도의 오피스 애플리케이션을 설치할 

오피스 파일들이 보여지게 됩니다. 

 

 

가능합니다. Office 

 

보여집니다. 이 매크로는 

확장자를 지원합니다. 

 필요가 없으며, 
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6 협업협업협업협업(Collaboration)

6.1 네트워킹네트워킹네트워킹네트워킹 살펴보기살펴보기살펴보기살펴보기 

자신에게 중요한 사람들과의 네트워크를

안의 누군가가 다음의 활동을 할

• 페이지나 블로그 포스트를

• 페이지나 블로그 포스트에

• 그들의 사용자 상태를

• 그들의 사용자 프로필을

 

다른다른다른다른 사용자사용자사용자사용자 팔로우팔로우팔로우팔로우 

다른 사용자를 Hover Profile 

팔로우하는 경우 다른 사용자의

 

네트워크네트워크네트워크네트워크 뷰를뷰를뷰를뷰를 통한통한통한통한 다른다른다른다른 사용자사용자사용자사용자

1. 스크린의 우측 상단에

2. 팔로잉 필드에서 찾고자하는

3. 팔로우 버튼을 클릭합니다

리프레시하거나 네트워크 뷰를 

나타나게 되며, 그들의 활동 또한

 

6.2 사용자사용자사용자사용자 상태상태상태상태 업데이트업데이트업데이트업데이트 

사용자 상태를 설정함으로써 다른

메시지를 브로드캐스트로 보낼 
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(Collaboration) 

네트워크를 만들 수 있으며, 팀원이나 상사를 팔로우 할 수 있습니다

할 경우 확인할 수 있습니다. 

포스트를 추가, 수정하는 경우 

포스트에 코멘트를 작성하거나, 기존의 코멘트를 수정하는 경우

상태를 업데이트하는 경우 

프로필을 업데이트하는 경우  

Hover Profile 또는 네트워크 뷰를 통해 팔로우 할 수 있습니다. Hover Profile 

사용자의 프로필에 마우스 커서를 올린 뒤 나타나는 페이지에서 팔로우

사용자사용자사용자사용자 팔로우팔로우팔로우팔로우 

상단에 있는 현재 사용자의 프로필을 클릭 후 네트워크를 선택합니다

찾고자하는 사용자를 검색 후 선택합니다. 

클릭합니다. 

 다시 방문할 경우 팔로우한 사용자의 프로필 사진이 우측의 

또한 Recent activity 리스트에 나타나게 됩니다.  

 

다른 컨플루언스 사용자들이 당신이 현재 무엇을 생각하는지를

 수 있습니다. 당신을 팔로우하는 다른 사용자들은 당신의 상태를

 

있습니다. 만약 네트워크 

경우 

Hover Profile 을 통해 

팔로우 버튼을 클릭합니다. 

선택합니다. . 

 팔로잉 리스트에 

생각하는지를 알려주거나, 짧은 

상태를  대시보드의 
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Recent activity 스트림 또는 

사용자가 당신의 프로필을 호버링할

사용자사용자사용자사용자 상태를상태를상태를상태를 설정설정설정설정 또는또는또는또는 업데이트하기업데이트하기업데이트하기업데이트하기

1. 우측 상단에 있는 프

on’ 입력 필드가 열립니다

2. 짧은 메시지를 입력합니다

3. 업데이트 버튼을 클릭합니다

 

다른 사람의 컨플루언스 사용자

컨플루언스는 해당 사용자에게 

NOTE. 상태상태상태상태 업데이트의업데이트의업데이트의업데이트의

않습니다않습니다않습니다않습니다. 

 

사용자사용자사용자사용자 상태상태상태상태 보기보기보기보기  

당신의 ‘Status Updates’ 뷰는

위해선 스크린 우측 상단의 프로필

그들의 프로필을 클릭하세요. 또한

삭제할 수 있습니다.  
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 그들의 네트워크 페이지에서 확인할 수 있습니다. 당신의 현재

호버링할 경우 보여집니다.  

업데이트하기업데이트하기업데이트하기업데이트하기 위해위해위해위해 다음과다음과다음과다음과 같이같이같이같이 설정합니다설정합니다설정합니다설정합니다.  

프로필 사진을 선택한 뒤 Update Status를 누릅니다. (“What are you working 

열립니다) 

입력합니다. (최대 140글자까지 가능합니다) 

클릭합니다. 

사용자 이름을 [~사용자이름] 을 통해 당신의 staus update에 포함시킬

 당신의 상태 업데이트와 함께 이메일을 보내게 됩니다.  

업데이트의업데이트의업데이트의업데이트의 멘션의멘션의멘션의멘션의 경우경우경우경우 컨플루언스컨플루언스컨플루언스컨플루언스 워크박스에워크박스에워크박스에워크박스에 알림과알림과알림과알림과 같이같이같이같이 보여지지는보여지지는보여지지는보여지지는

뷰는 당신의 상태 업데이트의 히스토리를 보여줍니다. 당신의 상태

프로필 사진을 선택 후 Status Updates를 클릭합니다. 다른 

또한 가장 최근의 상태 업데이트를 클리어하거나, 지난 업데이트에

 

현재 상태 메시지는 다른 

What are you working 

포함시킬 수 있습니다. 

보여지지는보여지지는보여지지는보여지지는 

상태 업데이트 뷰를 보기 

 사용자의 상태를 보려면 

업데이트에 대한 내용을 
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상태상태상태상태 업데이트업데이트업데이트업데이트 켜고켜고켜고켜고 끄기끄기끄기끄기  

상태 업데이트 기능은 ‘User Status

플러그인을 diable 하시면 됩니다

권한을 설정할 수 있으며, 기본적으로

 

6.3 멘션멘션멘션멘션 사용하기사용하기사용하기사용하기 

멘션은 일반적으로 @멘션  과 

할당할 때 좋은 기능입니다. 어떤

통해 알림을 받게 됩니다. 만약 

list에 나타나게 됩니다.  

멘션을 사용하는 방법은 두 가지로

방법이 있습니다.  

autocomplete 사용사용사용사용 

어떤 사용자에게 autocomplete

자동완성기능으로 검색되는 사용자
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User Status’ 플러그인을 통해 제공됩니다. 사이트에서 상태 업데이트를

됩니다. 또한 컨플루언스 사이트에서 어떤 사용자가 상태 업데이트

기본적으로 일반 유저는 이 기능을 사용할 권한을 가지지 않습니다

 같이 알려진 기능으로 어떤 사람에게 페이지나 코멘트에 대한

어떤 사용자에 대해 멘션을 사용할 때 해당 사용자는 이메일이나

 task에서 멘션을 할 경우 해당 사용자에게 task가 부여되며

가지로 autocomplete를 사용하거나 editor toolbar의 Insert menu

autocomplete를 사용하기 위해선 ‘@’를 해당 사용자의 이름 앞에 넣고

사용자 중에서 원하는 사용자를 선택합니다.  

 

 

업데이트를 삭제하고 싶다면 

업데이트 기능을 사용할 지 

않습니다.  

대한 알림, 또는 업무를 

이메일이나 그들의 워크박스를 

부여되며 해당 사용자의 tasks 

nsert menu를 사용하는 

넣고 작성합니다. 
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Insert menu 사용사용사용사용 

Insert menu를 사용하고자 한다면

검색합니다.  

NOTE. 그룹에그룹에그룹에그룹에 대한대한대한대한 멘션기능은멘션기능은멘션기능은멘션기능은

있습니다있습니다있습니다있습니다. 또한또한또한또한 [사용자명사용자명사용자명사용자명

알림알림알림알림 메일을메일을메일을메일을 보내게보내게보내게보내게 됩니다됩니다됩니다됩니다

 

6.4 페이지와페이지와페이지와페이지와 블로그블로그블로그블로그 포스트포스트포스트포스트

컨플루언스의 ‘Share’옵션을 통해

사람은 컨플루언스 사용자가 될

컨플루언스컨플루언스컨플루언스컨플루언스 페이지나페이지나페이지나페이지나 블로그블로그블로그블로그 포스트의포스트의포스트의포스트의

1. 공유하려는 페이지나

2. Share를 선택합니다

서버를 설정해두었을

3. 사용자명, 그룹명 또는

명에게 보낼 경우 같은

4. 노트박스에 추가적으로

5. Share버튼을 선택하여

우측에 있는 delete
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한다면 Insert 에서 User Mention을 선택한 뒤 멘션을 남기고

멘션기능은멘션기능은멘션기능은멘션기능은 제공되지제공되지제공되지제공되지 않으며않으며않으며않으며, 오직오직오직오직 개별개별개별개별 사용자에게만사용자에게만사용자에게만사용자에게만 사용할사용할사용할사용할

사용자명사용자명사용자명사용자명]을을을을 통해통해통해통해 링크를링크를링크를링크를 걸걸걸걸 수수수수 있으며있으며있으며있으며, 이는이는이는이는 멘션과멘션과멘션과멘션과 같이같이같이같이 해당해당해당해당 사용자에게사용자에게사용자에게사용자에게

됩니다됩니다됩니다됩니다.  

포스트포스트포스트포스트 공유공유공유공유 

통해 .누구에게나 페이지나 블로그 포스트의 링크를 이메일로

될 수도, 또는 어떤 이메일 주소라도 될 수 있습니다.  

포스트의포스트의포스트의포스트의 링크를링크를링크를링크를 공유하기공유하기공유하기공유하기 위한위한위한위한 방법방법방법방법  

페이지나 블로그 포스트로 이동합니다. 

선택합니다. (Share 버튼은 오직 컨플루언스 관리자가 컨플루언스 사이트의

설정해두었을 경우에만 보이게 됩니다.) 

또는 이메일 주소를 적고 자동완성되는 내용 중 해당하는 것을

같은 방법을 반복합니다. 

추가적으로 적을 내용이 있으면 추가합니다. 

선택하여 메일을 통해 링크를 보냅니다. (리스트에서 수령인을 제외하려면

delete아이콘을 선택합니다) 

 

 

남기고 싶은 사용자를 

사용할사용할사용할사용할 수수수수 

사용자에게사용자에게사용자에게사용자에게 

이메일로 보낼 수 있습니다. 받는 

사이트의 outgoing 메일 

것을 선택합니다. 여러 

제외하려면 수령인의 
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6.5 페이지와페이지와페이지와페이지와 블로그블로그블로그블로그 포스트에포스트에포스트에포스트에

코멘트는 다른 사용자를 페이지나

체크하거나 중요한 정보를 추가하고

어떤 페이지나 블로그 포스트의

인라인 코멘트를 추가할 수 있습니다

페이지나페이지나페이지나페이지나 블로그블로그블로그블로그 포스트에포스트에포스트에포스트에 코멘트코멘트코멘트코멘트

1. 페이지의 하단에 있는

2. 추가옵션으로 프리뷰

3. 기본적으로 Watch this page 

알림을 받지 않기 위해선

4. Save 를 선택합니다

다른 사용자들은 해당 코멘트에

수정할 수 있습니다.  

 

Inline comment 추가추가추가추가하기하기하기하기 
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포스트에포스트에포스트에포스트에 코멘트코멘트코멘트코멘트 추가추가추가추가 

페이지나 블로그 포스트의 대화에 불러오는 좋은 방법입니다. 코멘트를

추가하고, 질문 등을 통해 협업을 이끌어낼 수 있습니다.  

포스트의 하단에든 코멘트를 추가할 수 있으며, 페이지의 특정 텍스트에

있습니다. 

코멘트코멘트코멘트코멘트 추가하기추가하기추가하기추가하기  

있는 코멘트 필드에 코멘트를 입력합니다. 

프리뷰 버튼을 통해 코멘트가 어떻게 보여질지 알 수 있습니다. 

Watch this page 옵션이 선택됩니다. (해당 페이지에 대해 알림을

위해선 해당 옵션의 체크를 해제해야 합니다.) 

선택합니다.  

코멘트에 대해 답변을 달거나 좋아요를 할 수 있으며, 관리자나 작성자는

 

 

 

코멘트를 통해 콘텐츠를 

텍스트에 하이라이팅을 통해 

알림을 받게 된다는 의미이며, 

작성자는 해당 코멘트를 
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1. 코멘트를 추가하고 싶은

2. 그 위에 살짝 커서를

3. 적고 싶은 코멘트를 

선택된 텍스트는 인라인 코멘트가

코멘트가 보여지게 됩니다.  

 

Inline comment Resolve

대화가 끝난 경우 인라인 코멘트를

를 선택한 뒤 Resolved comment

 

Rich 코멘트코멘트코멘트코멘트 

인라인과 페이지 코멘트는 단순해

붙은 리스트, 링크, @멘션 등이

코멘코멘코멘코멘트트트트 권한권한권한권한 

• 코멘트 추가 - 스페이스에서
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싶은 텍스트에 하이라이트를 합니다. 

커서를 올릴 경우 나오는 버튼을 클릭합니다. 

 적고 Save를 선택합니다. 

코멘트가 포함된 노란색 하이라이트로 보여지며 해당 텍스트를 선택할

Inline comment Resolve 하기하기하기하기  

코멘트를 숨기기 위해 Resolve 를 클릭합니다. Resolve된  코멘트를

Resolved comment메뉴로 들어간 뒤 좌측하단에 있는 reopen을 선택하여

단순해 보일 수 있으나 rich 텍스트를 지원합니다. (굵기굵기굵기굵기, 밑줄, 기울임

등이 있으며, 어떤 코멘트에든 이미지를 넣거나 할 수 있습니다. 

스페이스에서 ‘Add Comments’ 권한이 필요합니다.  

 

 

선택할 경우 연관된 

코멘트를 보기 위해서는 

선택하여 선택합니다.  

기울임) 그 외 번호가 

.  
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• 코멘트 수정 - 스페이스에서

모든 코멘트들의 수정이

• 코멘트 삭제 - 스페이스에서

불가능합니다. ‘Remove Comments

코멘트만 지울 수 있습니다

• 코멘트 비사용 – 만약

'users' , anonymous 

스페이스의 페이지나

NOTE. 페이지에페이지에페이지에페이지에 누군가누군가누군가누군가

우측우측우측우측 상단의상단의상단의상단의 Watch 를를를를

코멘트의코멘트의코멘트의코멘트의  순서를순서를순서를순서를 변경하는변경하는변경하는변경하는

 

6.6 이메일이메일이메일이메일 알림알림알림알림 

스페이스나 페이지, 블로그 포스트를

업데이트하였을 때 컨플루언스는

업데이트들에 대한 알림을 매일

단, 볼 수 있도록 허가된 콘텐츠에

이메일 알림을 받을 수 없습니다

다음의 경우에 대해 요약된 이메일

• 볼 수 있는 모든 스페이스들의

• 볼 수 있는 모든 스페이스들과

• 볼 수 있는 모든 스페이스들과

• 다른 사용자가 자신을

• 볼 수 있는 모든 스페이스들의

이메일이메일이메일이메일 알림알림알림알림 설정을설정을설정을설정을 변경하는변경하는변경하는변경하는 방법방법방법방법
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스페이스에서 ‘Add Comments’ 권한이 필요합니다. 관리자는 해당

수정이 가능합니다. 코멘트의 날짜는 항상 가장 최근에 수정된 

스페이스에서 ‘Remove Comments’ 권한이 필요합니다. 지울

Remove Comments’ 권한이 없을 경우, 본인의 코멘트일지라도

있습니다.  

만약 특정 스페이스에서 코멘트를 사용하지 않기를 원한다면, 'confluence

anonymous 사용자들에 대해 ‘Add Comments’ 권한을 지우면 됩니다

페이지나 블로그 포스트 등에서 add comment 옵션이 보이지 않게

누군가누군가누군가누군가 수정하거나수정하거나수정하거나수정하거나 코멘트를코멘트를코멘트를코멘트를 추가하였을추가하였을추가하였을추가하였을 경우경우경우경우 알림을알림을알림을알림을 받기받기받기받기 위해서는위해서는위해서는위해서는

를를를를 선택하십시오선택하십시오선택하십시오선택하십시오. 또한또한또한또한 페이지에서페이지에서페이지에서페이지에서  모든모든모든모든 코멘트를코멘트를코멘트를코멘트를 동시에동시에동시에동시에 지우거나지우거나지우거나지우거나

변경하는변경하는변경하는변경하는 것은것은것은것은 불가능합니다불가능합니다불가능합니다불가능합니다.  

포스트를 ‘watch’ 할 수 있을 경우, 누군가가 해당 사항에 대하여

컨플루언스는 이메일을 통해 알림을 보내주게 됩니다. 또한 이메일 리포트와

매일 구독할 수 있습니다. 

콘텐츠에 대해서만 알림을 받을 수 있으며, 관리자에 의해 Disable

없습니다.  

이메일 리포트를 구독할 수 있습니다.  

스페이스들의 업데이트 내역들에 대한 일간 리포트 

스페이스들과 블로그 포스트들의 추가 및 변경 사항에 대한 즉각적인

스페이스들과 팔로잉중인 사용자의 모든 업데이트에 대한 즉각적인

자신을 팔로잉하였을 경우에 대한 즉각적인 리포트 

스페이스들의 추천할만한 업데이트 내역들에 대한 일간, 주간 리포트

방법방법방법방법  

 

해당 스페이스 내에서 

 시각으로 표시됩니다.  

지울 경우 복원은 

코멘트일지라도 답변이 없는 

'confluence-users' 나 

됩니다. 이후 해당 

않게 됩니다.  

위해서는위해서는위해서는위해서는 페이지페이지페이지페이지 

지우거나지우거나지우거나지우거나 

대하여 콘텐츠를 추가하거나 

리포트와 다양한 

Disable된 사용자의 경우 

즉각적인 리포트 

즉각적인 리포트 

리포트 
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1. 우측 상단의 프로필 

2. 좌측 패널의 Email

3. Edit를 클릭합니다.

 

아래는아래는아래는아래는 이메일이메일이메일이메일 설정에설정에설정에설정에 대한대한대한대한 설명입니다설명입니다설명입니다설명입니다

Setting Description

Autowatch Option: 컨플루언스가

자동적으로

업데이트한

포스트에 

등록하는 

여부. 페이지나

watcher 일

내용에 대한

있습니다 

Subscribe 

to daily 

updates 

볼 수 있는

대해 콘텐츠의

경우 이메일

있습니다

Note: 일간

페이지나

attachment

수정, 삭제정보는

않습니다

Subscribe 

to all blog 

posts 

볼 수 있는

컨플루언스의

변경사항에

알림을 받을

Subscribe 

to network 
팔로잉중인

변경 중 볼

것에 대해
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 사진을 클릭한 뒤 Settings 를 선택합니다. 

Email을 클릭합니다. 

. 

설명입니다설명입니다설명입니다설명입니다. 

Description Content 

컨플루언스가 

자동적으로 본인이 만들거나 

업데이트한 페이지 또는 블로그 

 대해 watcher 로 

 것을 허용할 것인지 

페이지나 포스트의 

일 경우 차후 변경될 

대한 알림을 받을 수 

 

• 해당 사용자가 페이지나 

블로그 포스트를 만들거나

수정, 코멘트를 달았을 경우

있는 모든 스페이스들에 

콘텐츠의 변경이 있을 

이메일 리포트를 받을 수 

있습니다 

일간 이메일 리포트는 

페이지나 블로그 포스트의 

attachment 에 대한 추가, 

삭제정보는 포함하지 

않습니다 

• 페이지와 블로그 포스트가

추가, 수정, 삭제되었을 경우

• 페이지나 블로그 포스트에

코멘트가 추가, 수정, 

삭제되었을 경우 

• 사용자가 Personal 프로필을

수정하였을 경우 

있는 권한을 가진 

컨플루언스의 블로그 

변경사항에 대한 이메일 

받을 수 있습니다 

• 블로그 포스트가 추가, 수정

삭제되었을 경우 

팔로잉중인 사용자의 콘텐츠 

볼 수 있는 권한이 있는 

대해 이메일 알림을 받을 

• 페이지가 추가, 수정, 

삭제되었을 경우 

• 블로그 포스트가 추가, 수정

 

Frequency 

만들거나, 

경우  

해당없음 

포스트가 

경우 

포스트에 

프로필을 

매일 

수정, 즉시 

수정, 

즉시 
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수 있습니다

Subscribe 

to new 

follower 

notification 

다른 사용자가

팔로잉하기

이메일 알림을

있습니다

Notifiy on 

my actions 
Option: 본인

사항에 대해

받고 싶은지

Note: 만약

대해서도

스페이스

watch 를

‘Notify on my actions

기능은 아무것도

것입니다

Show 

changed 

content 

Option: 콘텐츠의

중 세부사항에

받고 싶은지

• 이 옵션을

경우

페이지의

페이지를

적은

포함합니다

• 이 옵션을

알림은

버전의

차이를

Subscribe 

to 
스페이스에서
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있습니다.  삭제되었을 경우 

• 코멘트가 추가, 수정, 

삭제되었을 경우 

• 사용자에 의해 Status 가 

변경되었을 경우  

사용자가 본인을 

팔로잉하기 시작하였을 경우 

알림을 받을 수 

있습니다 

 

본인 스스로의 변경 

대해 이메일 알림을 

싶은지 여부 

만약 어떤 이메일에 

대해서도 알림을 받지않거나 

스페이스, 페이지에 대해 

를 하지 않을 경우 

Notify on my actions’ 

아무것도 하지 않을 

것입니다. 

• Watching 하는 모든 

스페이스와 페이지 

• 이것은 모든 subscription 

설정에 영향을 미칩니다 

콘텐츠의 변경된 내용 

세부사항에 대해 알림을 

싶은지 여부 

옵션을 선택하지 않을 

경우 알림은 오직 

페이지의 제목, 저자가 

페이지를 업데이트하면서 

적은 코멘트만 

포함합니다 

옵션을 선택할 경우, 

알림은 현재 버전과 이전 

버전의 페이지 간의 

차이를 보여줍니다  

• 페이지와 블로그 포스트를

수정할 경우 

스페이스에서 본인과 연관된 컨플루언스는 다음 사항에 

 

즉시 

subscription 

 

해당없음 

포스트를 해당없음 

매일 또는 
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recommend

er updates 
상위의 콘텐츠

권한이 있는

알림을 받을

이메일 메시지

일간, 주간등의

설정할 수

이메일 메시지에

클릭함으로써

수 있습니다

프로필에
recommended updates

옵션을 통해

수 있습니다

Atlassian Confluence 5.8.X User Guide 

Page 84 

콘텐츠 중 볼 수 있는 

있는 것에 대해 이메일  

받을  있습니다. 

메시지 링크를 통해 

주간등의 알림빈도를 

수 있습니다. 

메시지에 있는 링크를 

클릭함으로써 알림설정을 끌 

있습니다. 또한 사용자 

프로필에 있는 ‘Subscribe to 

recommended updates’ 

통해 이 설정을 켜고 끌 

있습니다.  

기초하여 보여줄 콘텐츠를 

선택할 수 있습니다. 

• 최근에 사람들이 좋아한

페이지와 블로그 포스트

• 최근에 사람들이 코멘트를

작성한 페이지와 블로그

포스트 

• 최근에 만들어진 페이지와

블로그 포스트 

‘최근’의 의미는 본인에게 

마지막으로 업데이트 메시지가

간 이후로 발생하는 어떤 

activity 를 의미합니다. 

activity 들은 가장 대중성의 

정도로 리스트업됩니다.  

좋아요, 코멘트와 콘텐츠의 

생성은 같은 점수를 가지며, 

본인의 네트워크에 있는 

사람들의 activity 가 그렇지 않은

사람들의 것보다 우선됩니다. 

본인의 favourite 스페이스에 

있는 콘텐츠가 다른 

스페이스들에 비해 우선권을 

가지며, 추천된 업데이트의 

요약은 본인이 만든 콘텐츠에

대해선 포함하지 않습니다. 또한

본인이 포함되어있는 

콘텐츠(코멘트를 달거나 

페이지를 업데이트하는 등)에

대해선 낮은 우선순위를 

부여합니다.   

만약 리포트할 어떤 activity 도

없을 경우 컨플루언스는 이메일

메시지를 보내지 않습니다.  

 

좋아한 

포스트 

코멘트를 

블로그 

페이지와 

메시지가 

않은 

. 

 

 

콘텐츠에 

또한 

에 

도 

이메일 

 

주간 
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관리자관리자관리자관리자 NOTE. 컨플루언스가컨플루언스가컨플루언스가컨플루언스가

서버를서버를서버를서버를 설정해주어야합니다설정해주어야합니다설정해주어야합니다설정해주어야합니다

설정할설정할설정할설정할 수수수수 있있있있으며으며으며으며 방법은방법은방법은방법은

Configuration 을을을을 

클릭하여클릭하여클릭하여클릭하여 설정합니다설정합니다설정합니다설정합니다. 

 

6.7 페이지페이지페이지페이지, 스페이스스페이스스페이스스페이스, 블로그블로그블로그블로그

페이지, 스페이스와 블로그 포스트를

누가 어느 시간에 업데이트를 하더라도

다음의 사항에 대해서 알림 메일을

• 수정 (저자가 ‘Notify watchers

• 삭제 

• 새로운 첨부파일을 추가하거나

• 새로운 코멘트를 추가하거나

기본적으로, 컨플루언스는 본인이

되며, 이 기능을 ‘autowatch’라고

이메일 알림은 누군가가 어떠한

이메일 알림이 오지 않습니다.  

페이지와 스페이스, 블로그 포스트에

 

페이지와페이지와페이지와페이지와 블로그블로그블로그블로그 포스트포스트포스트포스트 감시감시감시감시하기하기하기하기

페이지와 블로그 포스트를 감시하기

1. 페이지나 블로그 포스트로

2. Watch를 선택한 뒤
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컨플루언스가컨플루언스가컨플루언스가컨플루언스가 이메일이메일이메일이메일 알림을알림을알림을알림을 보내기보내기보내기보내기 위해선위해선위해선위해선 시스템시스템시스템시스템 관리자가관리자가관리자가관리자가 반드시반드시반드시반드시

설정해주어야합니다설정해주어야합니다설정해주어야합니다설정해주어야합니다. 또한또한또한또한 컨플언스컨플언스컨플언스컨플언스 관리자는관리자는관리자는관리자는 추천추천추천추천 업데이트의업데이트의업데이트의업데이트의 알림의알림의알림의알림의 기본옵션을기본옵션을기본옵션을기본옵션을

방법은방법은방법은방법은 다음과다음과다음과다음과 같습니다같습니다같습니다같습니다. 우측우측우측우측 상단의상단의상단의상단의 톱니바퀴톱니바퀴톱니바퀴톱니바퀴 모양을모양을모양을모양을 클릭하여클릭하여클릭하여클릭하여, General 

 선택한선택한선택한선택한 뒤뒤뒤뒤 좌측좌측좌측좌측 패널의패널의패널의패널의 Recommended Updates Email

 

블로그블로그블로그블로그 감시감시감시감시(Watch) 

포스트를 ‘watch’ 할 수 있으며, 컨플루언스는 본인이 ‘watch’

하더라도 알림 메일을 보내줍니다.  

메일을 받게 됩니다.  

Notify watchers’ 체크박스를 초기화하지 않는 한) 

추가하거나 기존 첨부파일을 삭제하였을 경우  

추가하거나 기존 코멘트를 수정, 삭제하였을 경우 

본인이 생성하거나 수정한 페이지나 블로그 포스트에 대해 watcher 

라고 합니다.  

어떠한 변화를 일으킬 때마다 매번 발생하며, 매크로에 의해서 발생하는

 

포스트에 대한 ‘View’ 권한이 있어야만 알림을 받을 수 있습니다

하기하기하기하기 

감시하기 위해서 다음과 같이 설정합니다.  

포스트로 이동합니다. . 

뒤 연관된 체크박스를 선택합니다.  

 

반드시반드시반드시반드시 이메이메이메이메일일일일 

기본옵션을기본옵션을기본옵션을기본옵션을 

, General 

Recommended Updates Email 을을을을 

’  중인 콘텐츠에 대해 

watcher 역할을 할당하게 

발생하는 변화에 대해서는 

있습니다. 
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페이지와 블로그 포스트를 감시를

 

전체전체전체전체 스페이스스페이스스페이스스페이스 감시하기감시하기감시하기감시하기 

특정 스페이스에서 모든 페이지와

가장 빠른 방법은 위에서 설명드린

스페이스 감시를 멈추려면 연관된

다른 방법으로, 스페이스의 사이드바에

됩니다. 

만약 스페이스에서 Documentation theme

선택하신 뒤 좌측 핸드메뉴의

 

스페이스의스페이스의스페이스의스페이스의 모든모든모든모든 새로운새로운새로운새로운 블로그블로그블로그블로그 

누군가가 스페이스 내에 새로운

블로그 포스트의 업데이트나 삭제

새로운 포스트를 감시하기 위해서

1. 스페이스의 블로그 포스트로

2. Watch를 선택한 뒤

새로운 블로그 포스트에 대한 감시를

Blog를 선택한 뒤 우측 상단에

만약 스페이스에서 Documentation theme

선택하신 뒤 좌측 핸드메뉴의

 

 

사이트의사이트의사이트의사이트의 모든모든모든모든 스페이스스페이스스페이스스페이스 감시하기감시하기감시하기감시하기
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감시를 멈추기 위해선 연관된 체크박스의 선택을 해제합니다. 

페이지와 블로그 포스트를 감시하도록 설정할 수 있습니다. 

설명드린 바와 같이 페이지나 블로그 포스트의 Watch 옵션을 사용하는

연관된 체크박스를 선택해제하면 됩니다.  

사이드바에 있는 Pages를 선택 후 우측 상단의 Watch this space

Documentation theme 을 사용 중이라면, Browse > Space Operations 

핸드메뉴의 Watch this space 를 선택합니다.  

 포스트포스트포스트포스트 감시하기감시하기감시하기감시하기  

새로운 블로그 포스트를 추가하였을 경우, 해당 알림을 받도록 설정할

삭제, 코멘트들에 대해서 알림을 받지 않도록 설정할 수도 있습니다

위해서 다음과 같이 설정합니다.  

포스트로 이동합니다. 

뒤 Watch all blog posts in this space 를 선택합니다

감시를 멈추려면 연관된 체크박스의 선택을 해제합니다. 또는

상단에 있는 Watch this blog를 선택합니다.  

Documentation theme 을 사용 중이라면, Browse > Space Operations 

핸드메뉴의 Watch this blog 를 선택합니다. 

감시하기감시하기감시하기감시하기 

 

사용하는 방법입니다. 

Watch this space를 선택하여도 

, Browse > Space Operations 를 

설정할 수 있으며, 또한 

있습니다.  

선택합니다.  

또는 스페이스 사이드바의 

, Browse > Space Operations 를 
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컨플루언스 사이트에 존재하는 

알림을 받을 수 있습니다.  

사이트 전체의 콘텐츠 변화를 감시하기

1. 우측 상단의 프로필 

2. Email을 선택합니다

3. Edit를 선택한 뒤 Subscribe to daily updates

4. Submit을 선택합니다

 

사이트의사이트의사이트의사이트의 모든모든모든모든 새로운새로운새로운새로운 블로그블로그블로그블로그 포스트포스트포스트포스트

컨플루언스 사이트의 모든 스페이스에

블로그 포스트들의 업데이트 및

모든 새로운 블로그 포스트들을

1. 우측 상단의 프로필 

2. Email을 선택합니다

3. Edit를 선택한 뒤 Subscribe to blog posts

4. Submit을 선택합니다

 

사용자사용자사용자사용자 프로필에서프로필에서프로필에서프로필에서 감시옵션감시옵션감시옵션감시옵션 조절하기조절하기조절하기조절하기

사용자 프로필의 “Watches”페이지는

감시 옵션을 조절하기 위해 다음과

1. 우측 상단의 프로필 

2. 보고 싶지 않은 스페이스와
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 모든 스페이스들의 페이지의 콘텐츠 변경 내역과 블로그 포스트와

감시하기 위해서 다음과 같이 설정합니다.   

 사진을 선택한 뒤 Settings를 클릭합니다. 

선택합니다 

Subscribe to daily updates를 선택합니다. 

선택합니다. 

포스트포스트포스트포스트 감시하기감시하기감시하기감시하기 

스페이스에 새로 생성되는 모든 새로운 블로그 포스트들을 감시할

및 삭제, 코멘트들에 대한 알림을 받지 않을 수도 있습니다.  

포스트들을 감시하기 위해서 다음과 같이 설정합니다.   

 사진을 선택한 뒤 Settings를 클릭합니다  

선택합니다 

Subscribe to blog posts를 선택합니다. 

선택합니다. 

조절하기조절하기조절하기조절하기 

페이지는 현재 감시중인 모든 스페이스와 페이지에 대해 보여줍니다

다음과 같이 설정합니다.  

 사진을 선택한 뒤 Watches를 클릭합니다  

스페이스와 페이지들에 대해 Stop Watching을 선택합니다. 

 

포스트와 코멘트들에 대해 

감시할 수 있습니다. 또한 

 

보여줍니다.  
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이메일이메일이메일이메일 메시지에서메시지에서메시지에서메시지에서 감시옵션감시옵션감시옵션감시옵션 조절하기조절하기조절하기조절하기

컨플루언스로부터 받는 이메일 

링크들은 상황에 따라 다르거나

달 수 있는 등의 기능을 제공합니다

알림 설정을 어떻게 설정했느냐에

• Stop watching page 

• Stop watching space 

• Stop following this user 

업데이트에 의한 이메일

• Manage Notifications 

이메일 알림의 하단 링크는 다음과

 

 

Autowatch 와와와와 기타기타기타기타 알림알림알림알림 옵션옵션옵션옵션

기본적으로, 컨플루언스는 본인이

되며, 이 기능을 ‘autowatch’라고

있습니다.  
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조절하기조절하기조절하기조절하기  

 알림에는 하단의 이메일 메시지에 유용한 링크들이 포함되어

다르거나 의존적이지만, 일반적으로 해당 페이지를 온라인으로 보여주거나

제공합니다.  

설정했느냐에 따라 다음의 링크들 중 한 개 또는 그 이상의 링크를 보게

Stop watching page – 이 링크를 클릭하여 해당 페이지에 대해 감시하지 않도록

Stop watching space – 이 링크를 클릭하여 해당 스페이스에 대해 감시하지

Stop following this user – 이 링크를 클릭하여 해당 유저의 팔로잉을 그만두어

이메일 알림을 받지 않도록 설정합니다.  

Manage Notifications – 이 링크를 클릭하여 사용자 프로필의 이메일 설정 페이지로

다음과 같이 보여집니다.  

옵션옵션옵션옵션 

본인이 생성하거나 수정한 페이지나 블로그 포스트에 대해 watcher 

라고 합니다. 이 옵션은 사용자 프로필에서 기타 알림 옵션들과

 

포함되어 있습니다. 각 메시지의 

보여주거나, 코멘트에 답변을 

보게 됩니다.  

않도록 설정합니다.  

감시하지 않도록 설정합니다. 

그만두어, 해당 유저의 

페이지로 이동합니다. 

 

watcher 역할을 할당하게 

옵션들과 함께 켜거나 끌 수 
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7 개인개인개인개인 설정설정설정설정(User Profile)

7.1 프로필프로필프로필프로필 살펴보기살펴보기살펴보기살펴보기 

사용자 프로필은 본인에 대한 기본적인

스페이스를 설정하지 않았다면 

본인의 프로필에서 계정관리, 본인정보

볼 수 있습니다. 

본인의본인의본인의본인의 프로필프로필프로필프로필 찾기찾기찾기찾기 

우측 상단의 본인의 프로필 사진을

링크를 선택합니다.  

 

다른다른다른다른 사용자의사용자의사용자의사용자의 프로필프로필프로필프로필 찾기찾기찾기찾기 

마우스 포인터를 사용자의 링크된

프로필을 열어봅니다. 대체방법으론

아래와 같은 URL을 통해 직접적으로
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(User Profile) 

기본적인 정보를 가지고 있으며 다른 사용자들이 볼 수 있습니다

 People Directory에서 나의 이름을 다른 사용자가 클릭하여

본인정보 갱신(이름, 이메일, 패스워드 등)이 가능합니다. 또한

사진을 클릭한 뒤, Profile을 선택하거나 개인 스페이스의 사이드바에

링크된 이름이나 프로필사진에 올린 뒤 사용자의 링크된 이름을 

대체방법으론, 다른 사용자의 개인 스페이스의 사이드바에 있는 Profile 

직접적으로 접근할 수 있습니다.  

 

있습니다. 또한 개인 

클릭하여 볼 수 도 있습니다.  

또한 다른 사용자 프로필을 

사이드바에 있는 Profile 

 선택하여 그들의 

Profile 링크를 선택하거나, 
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http://MY.CONFLUENCE.COM/users/viewuserprofile.action?username=USERNAME

 

현재현재현재현재 사용자의사용자의사용자의사용자의 사용자사용자사용자사용자 프로필프로필프로필프로필 예시예시예시예시

 

 

 

사용자사용자사용자사용자 프로필에서프로필에서프로필에서프로필에서 접근가능한접근가능한접근가능한접근가능한 메뉴메뉴메뉴메뉴

Profile • 이름이나

있습니다

• 보안

한

Network • 네트워크

있습니다

• 이

Status Updates • 본인의

Favourites • 본인의

Watches • 본인이

Drafts • 수정

Settings • General 
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NFLUENCE.COM/users/viewuserprofile.action?username=USERNAME

예시예시예시예시 

메뉴메뉴메뉴메뉴 

이름이나 이메일주소 등의 개인 정보와 사진 등을 보거나

있습니다. 

보안 예방책으로 이메일 주소를 변경하기 위해선 본인의

한 번 입력해야만 합니다.  

네트워크 뷰를 통해 본인이 팔로잉하는 사용자의 최근 활동을

있습니다. 

이 뷰를 통해 다른 사용자를 팔로잉 할 수 있습니다. 

본인의 상태 업데이트들의 내역을 볼 수 있습니다. 

본인의 favourite 스페이스의 리스트를 볼 수 있습니다. 

본인이 현재 감시중인 스페이스와 페이지들의 리스트를

수정 중에 있던 페이지를 불러옵니다.  

General 설정(홈페이지, 언어와 타임존)을 수정할 수 있습니다

 

NFLUENCE.COM/users/viewuserprofile.action?username=USERNAME 

 

보거나 변경할 수 

본인의 패스워드를 다시 

활동을 볼 수 

.  

리스트를 볼 수 있습니다. 

있습니다. 
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• 이메일

• 본인의

 

사용자사용자사용자사용자 프로필프로필프로필프로필 수정하기수정하기수정하기수정하기 

1. 우측 상단의 프로필 

링크를 선택합니다. 

2. Edit Profile을 선택합니다

3. 보여지는 양식 안에 

4. Save를 선택합니다

 

사용자사용자사용자사용자 프로필의프로필의프로필의프로필의 양식양식양식양식 

Detail Description

Full Name 본인의 

Email 메일 알림을

Phone 본인의 

IM 본인의 

다양한 

허용합니다

입력하는

Website 본인의 

About me 본인에 

특기 등

있습니다

Position 조직에서

Department 본인의 

Location 본인의 
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이메일 알림을 구독할 수 있습니다 

본인의 OAuth access tokens 에 대해 보거나  폐기할 수 

 사진을 선택한 뒤 Profile을 선택하거나, 개인 스페이스의 사이드바에

 

선택합니다 

 본인에 대해 상세 내용을 기술합니다. 

선택합니다. 

Description 

 프로필에서 보여주고 싶은 이름을 기입합니다. 

알림을 받기 위해 사용될 이메일 주소를 기입합니다. 

 전화번호를 기입니다. 

 Instant 메신저의 상세내용을 기입합니다.  

 IM 애플리케이션들에 맞추기 위해 이 옵션은 어떤 문자열값이라도

허용합니다. 예를 들어 이메일 주소나 사용자 id 와 같이 ‘123456789

입력하는 것도 가능합니다.  

 Website URL 을 기입합니다. 

 대한 정보를 기입하여 다른 사용자가 볼 수 있도록 합니다

등) 또한 이 필드에선 Confluence wiki markup 기능을 사용할

있습니다. 

조직에서 본인의 지위나 직책을 기입합니다. 

 부서나 팀 이름을 기입합니다. 

 위치(지역이나 도시, 마을 등)를 기입합니다.  

 

 있습니다.  

사이드바에 있는 Profile 

문자열값이라도 

123456789’ 등을 

합니다. (취미나 

사용할 수 
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NOTE. ‘Administer User

이이이이 링크를링크를링크를링크를 클릭함으로써클릭함으로써클릭함으로써클릭함으로써

 

 

 

7.2 패스워드패스워드패스워드패스워드 변경하기변경하기변경하기변경하기 

컨플루언스의 패스워드를 변경하려

• 로그인 한 상태에서 

• 패스워드를 잃어버린

로그인로그인로그인로그인 한한한한 상태에서상태에서상태에서상태에서 패스워드를패스워드를패스워드를패스워드를 

1. 우측 상단의 프로필 

2. Profile 탭에서 좌측

3. 보여지는 양식에 현재의

4. Submit을 클릭합니다

 

로그인로그인로그인로그인 페이지에서페이지에서페이지에서페이지에서 패스워드를패스워드를패스워드를패스워드를 리셋할리셋할리셋할리셋할

만약 패스워드를 잃어버려 리셋을해야

password?’ 링크를 선택한 뒤

 

7.3 사용자사용자사용자사용자 설정설정설정설정 편집편집편집편집 

다음의 메뉴들을 통해 컨플루언스를

• General Preferences (
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Administer User’ 링크의링크의링크의링크의 경우경우경우경우 컨플루언스컨플루언스컨플루언스컨플루언스 관리자에게만관리자에게만관리자에게만관리자에게만 보여집니다보여집니다보여집니다보여집니다

클릭함으로써클릭함으로써클릭함으로써클릭함으로써 바로바로바로바로 관리관리관리관리 콘솔로콘솔로콘솔로콘솔로 이동하여이동하여이동하여이동하여 유저유저유저유저 관리를관리를관리를관리를 할할할할 수수수수 있습니다있습니다있습니다있습니다.  

변경하려 할 경우 두 가지의 시나리오가 있습니다.  

 패스워드를 변경하려 할 경우 

버린 상태로 로그인을 하지 못하여 패스워드를 리셋해야할 경우

 변경할변경할변경할변경할 경우경우경우경우 

 사진을 선택한 뒤 Profile을 선택합니다.  

좌측 열에 있는 Password를 클릭합니다. 

현재의 패스워드와 새로 변경할 패스워드를 입력합니다. 

클릭합니다.  

리셋할리셋할리셋할리셋할 경우경우경우경우 

리셋을해야 할 경우컨플루언스 로그인 페이지에서 가능합니다. ‘

뒤 컨플루언스가 제공하는 패스워드 리셋 프로세스를 따라 패스워드를

컨플루언스를 본인에게 좀 더 맞는, 선호하는 방식으로 설정할 수 있습니다

ferences (홈페이지, 언어, 타임존) 

 

보여집니다보여집니다보여집니다보여집니다. 관리자는관리자는관리자는관리자는 

 

경우  

‘Forgot your 

패스워드를 리셋합니다.  

있습니다. 
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• Editor settings 

• Email settings for subscriptions to email reports

• 컨플루언스 사용자

 

General Preferences 

일반적인 사용자 설정을 변경하기

1. 우측 상단의 프로필 

2. Edit를 선택한 뒤 세팅을

3. Submit을 선택합니다

Setting 

Site Homepage 

Language 

Time zone 

Use Keyboard Shortcuts

 Text select 

 

사용자사용자사용자사용자 프로필프로필프로필프로필 설정의설정의설정의설정의 수정수정수정수정 화면화면화면화면
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Email settings for subscriptions to email reports 

사용자 계정으로부터 허가된 OAuth access tokens 

변경하기 

 사진을 선택한 뒤 Settings를 선택합니다.  

세팅을 업데이트합니다. 

선택합니다.  

Description 

본인이 컨플루언스에 로그인하였을 경우 보고 싶은

선택합니다. 

사용할 언어를 선택합니다. 

타임존을 선택합니다. 

Use Keyboard Shortcuts 편집자를 위해 키보드 단축키 설정을 활성화합니다

텍스트의 하이라이트된 패널에서 팝업 옵션을 해제합니다

화면화면화면화면 예시예시예시예시 

 

싶은 페이지를 

활성화합니다.  

해제합니다. 
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Editor Preferences 

컨플루언스에서 편집자가 어떻게

계정에만 영향을 미치며, 컨플루언스의

있습니다.  

본인의본인의본인의본인의 Editor Preferences 

1. 우측 상단의 프로필 

2. 좌측의 핸드 패널에서

3. 옵션 변경 후 Edit를

4. Submit을 클릭합니다

Setting 

Disable 

Autocomplete 

Disable 

Autoformatting 
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어떻게 사용할지에 대해 몇 가지 옵션을 설정할 수 있습니다. 이 설정들은

컨플루언스의 다른 유저들은 각각 본인의 계정에 대해 해당 설정을

Editor Preferences 변경하기변경하기변경하기변경하기 

 사진을 선택한 뒤 Settings를 선택합니다.  

패널에서 ‘Your Settings’ 아래에 있는 Editor를 클릭합니다. 

를 클릭합니다.  

클릭합니다. 

Description 

자동완성 기능을 비활성화합니다.  

편집기에서 wiki markup 기능을 비활성화합니다.  

 

 

설정들은 오직 해당 

설정을 활성화/비활성화 할 수 
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7.4 프로필프로필프로필프로필 사진사진사진사진 지정지정지정지정 

프로필 사진은 개인 스페이스의

사용됩니다. 또한 대시보드의 최근

프로필 사진을 업로드 할 때 크기를

프로필프로필프로필프로필 사진사진사진사진 업로드업로드업로드업로드 및및및및 조절하기조절하기조절하기조절하기

1. 우측 상단의 프로필 

2. 좌측의 Picture를 

3. Upload image를

4. 본인의 컴퓨터나 파일서버에서

5. 사진의 크기와 위치를

 

프로필프로필프로필프로필 사진의사진의사진의사진의 선택선택선택선택 예시예시예시예시 
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스페이스의 아이콘, 코멘트의 일러스트, People Directory에서 본인을

최근 업데이트내역의 본인 이름의 옆에 나오는 등 다양한 곳에서

크기를 조절하거나 위치를 조절할 수 있습니다.  

조절하기조절하기조절하기조절하기 

 사진을 선택한 뒤 Profile을 선택합니다.  

 클릭합니다. 

를 선택한 뒤 Upload an image를 클릭합니다. 

파일서버에서 사진을 선택하여 위치시킵니다. 

위치를 조절한 뒤 Save를 선택합니다.  

 

 

본인을 대표하는 것으로 

곳에서 나타납니다.  



Confidential 

 

 

 

Atlassian Confluence 5.8.X User Guide 

Page 96 
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7.5 홈페이지홈페이지홈페이지홈페이지 선택선택선택선택 

컨플루언스에 로그인 하면 기본

스페이스의 홈페이지를 로그인 

등록되게 됩니다.  

홈페이지홈페이지홈페이지홈페이지 설정하기설정하기설정하기설정하기 

1. 우측 상단의 프로필 

2. Edit를 선택합니다.

3. Site Homepage

보여지게 됩니다.  

4. Submit을 선택합니다

다음 로그인부터 바로 새로운 홈페이지로

있습니다.  

또한 여전히 아래와 같은 대시보드

https://yoursite.com/wiki/dashboard.action.

 

프로필프로필프로필프로필 설정예시설정예시설정예시설정예시 
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기본 대시보드가 보여집니다. 본인에게 맞는 홈페이지를 설정하기

 시 기본으로 보여지도록 설정할 수 있으며, 해당 홈페이지가

 사진을 선택한 뒤 Settings를 선택합니다.  

. 

Site Homepage의 드롭다운 메뉴에서 페이지를 선택합니다. ‘view’권한이 있는

 

선택합니다.  

홈페이지로 이동하게 되며, 사이트 로고를 클릭하여 개인 홈페이지로

대시보드 URL을 통해 사이트의 대시보드에 접근할 수 있습니다.

s://yoursite.com/wiki/dashboard.action. 

 

설정하기 위해서 다른 

홈페이지가 새로운 홈페이지로 

있는 스페이스들만 

홈페이지로 이동할 수 

. 
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7.6 스페이스와스페이스와스페이스와스페이스와 페이지페이지페이지페이지 즐겨찾기즐겨찾기즐겨찾기즐겨찾기

스페이스나 페이지를 즐겨찾기로

있습니다.  

페이지를페이지를페이지를페이지를 즐겨찾기로즐겨찾기로즐겨찾기로즐겨찾기로 추가하기추가하기추가하기추가하기 

1. 페이지로 이동합니다

2.  를 선택한 뒤

필요할 경우 해당 페이지를

 

스페이스를스페이스를스페이스를스페이스를 즐겨찾기로즐겨찾기로즐겨찾기로즐겨찾기로 추가하기추가하기추가하기추가하기

1. 컨플루언스의 헤더 부분의

2. 스페이스들의 리스트에서

즐겨찾기에 등록된 스페이스의 

즐겨찾기에서 제거할 수 있습니다
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즐겨찾기즐겨찾기즐겨찾기즐겨찾기 설정설정설정설정 

즐겨찾기로 등록하여 대시보드나 스페이스 디렉토리, 본인의 프로필로부터

 

이동합니다.  

뒤 Favourite를 클릭합니다. 메뉴 아이템이 Remove Favourite

페이지를 즐겨찾기에서 제거할 수 있습니다. 

추가하기추가하기추가하기추가하기 

부분의 Spaces를 선택 후 Space directory로 이동합니다

리스트에서 원하는 스페이스의 옆에 있는 별 모양 아이콘을 클릭합니다

 경우 별 모양 아이콘이 진회색으로 변하여 추가되었음을 보여주며

있습니다. 

 

 

프로필로부터 빠르게 접근할 수 

Remove Favourite로 바뀌며, 차후 

이동합니다.  

클릭합니다. 

보여주며, 다시 클릭할 경우 
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퍼스널퍼스널퍼스널퍼스널 스페이스를스페이스를스페이스를스페이스를 즐겨찾기로즐겨찾기로즐겨찾기로즐겨찾기로 추가하기추가하기추가하기추가하기

퍼스널 스페이스가 설정되어 있다면

스페이스 디렉토리에서 Personal Spaces

대해 즐겨찾기로 설정할 수 있습니다

 

본인의본인의본인의본인의 즐겨찾기즐겨찾기즐겨찾기즐겨찾기 보기보기보기보기 

본인의 즐겨찾기된 스페이스나 

• 대시보드의 좌측 하단

• 컨플루언스의 헤더 부분의

Favourite Spaces

• 우측 상단의 본인 프로필

즐겨찾기 스페이스에서 최근에 

피드에 보여집니다.  

 

본인본인본인본인 프로필에서프로필에서프로필에서프로필에서 즐겨찾기즐겨찾기즐겨찾기즐겨찾기 보기보기보기보기 

8 검색검색검색검색(Search) 

8.1 컨플루언스컨플루언스컨플루언스컨플루언스 검색검색검색검색 문법문법문법문법 

일치하는일치하는일치하는일치하는 문장문장문장문장 검색검색검색검색 
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추가하기추가하기추가하기추가하기 

있다면 다른 스페이스들을 즐겨찾기에 추가하는 것과 같이 추가할

Personal Spaces로 들어간 뒤 컨플루언스 사이트에서 볼 수 있는

있습니다. 

 페이지들을 보기 위해선 다음 중 하나의 방법을 따릅니다.  

하단에 network와 같이 즐겨찾기된 스페이스와 페이지 탭이 

부분의 Spaces를 선택 후 Space directory로 이동합니다

Favourite Spaces를 선택합니다.  

프로필 사진을 선택한 뒤 Favourites를 선택합니다.  

 업데이트된 콘텐츠 또한 대시보드의 Favourite Spaces 탭의

 예시예시예시예시 

 

 

추가할 수 있습니다. 

있는 퍼스널 스페이스에 

 

 보입니다. 

이동합니다. 이후 좌측의 

탭의 최근 액티비티 
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쌍따옴표를 써서 ‘cheese one

“cheese one” 

NOTE.컨플루언스는컨플루언스는컨플루언스는컨플루언스는 

words 로써로써로써로써 단어가단어가단어가단어가 쌍따옴표쌍따옴표쌍따옴표쌍따옴표

사용되는사용되는사용되는사용되는 이이이이 단어들의단어들의단어들의단어들의 

예시 

1. “cheese one”을 찾을

2. “the one”을 찾을 경우

 

OR 검색검색검색검색 

‘chalk’나 ‘cheese’ 중 어느 한

chalk OR cheese 

 

AND 검색검색검색검색 

‘chalk’나 ‘cheese’ 두 단어를

chalk AND cheese 

 

NOT 검색검색검색검색 

‘chalk’는 포함하지만 ‘cheese

chalk NOT cheese 

 

Excluded term 검색검색검색검색 
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cheese one’ 또는 ‘cheese’ 또는 ‘one’ 이라는 단어가 들어간 문장을 

컨플루언스는컨플루언스는컨플루언스는컨플루언스는 공용으로공용으로공용으로공용으로 쓰이는쓰이는쓰이는쓰이는 단어인단어인단어인단어인 ‘and’, ‘the’, ‘or’의의의의 경우경우경우경우 stop 

쌍따옴표쌍따옴표쌍따옴표쌍따옴표 안에안에안에안에 있더라도있더라도있더라도있더라도 무시하게됩니다무시하게됩니다무시하게됩니다무시하게됩니다. 컨플루언스컨플루언스컨플루언스컨플루언스 검색엔진에서검색엔진에서검색엔진에서검색엔진에서

 목록은목록은목록은목록은 Lucene 문서파일에서문서파일에서문서파일에서문서파일에서 확인할확인할확인할확인할 수수수수 있습니다있습니다있습니다있습니다. 

찾을 경우 ‘cheese’ 다음에 ‘one’이 오는 페이지를 보여줍니다

경우 ‘the’가 stop word이기에 ‘one’이 포함된 모든 페이지를

한 단어라도 포함된 콘텐츠를 찾습니다. OR은 대문자를 사용해야

단어를 모두 포함하는 콘텐츠를 찾습니다. AND는 대문자를 사용해야

cheese’ 는 포함하지 않는 콘텐츠를 찾습니다. NOT는 대문자를 

 

 찾습니다. 

검색엔진에서검색엔진에서검색엔진에서검색엔진에서 

보여줍니다. 

페이지를 보여줍니다.  

사용해야 합니다.  

사용해야 합니다.  

 사용해야 합니다.  
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‘chalk’와 ‘butter’는 포함하지만

chalk butter -cheese 

 

Group terms 검색검색검색검색 

‘chalk’는 반드시 포함하며, ‘butter

(cheese OR butter) AND chalk

 

Title 검색검색검색검색 

제목이 필드의 키워드일 때 ‘chalk

Title:chalk 

 

Date range 검색검색검색검색 

일정 시간 범위 내에서 생성되거나

‘yyyymmdd’형식을 따릅니다

created:[20000101 TO 20131231]

modified:[20000101 TO 

 

Wildcard 검색검색검색검색 

검색에서 한 개 또는 그 이상의 

어느 곳에나 위치시킬 수 있습니다

or ?ttps://confluence.atlassian

와일드카드는 문자 하나 또는 여러

문자문자문자문자 한한한한 개를개를개를개를 대체할대체할대체할대체할 경우경우경우경우 
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포함하지만 ‘cheese’ 는 포함하지 않는 콘텐츠를 찾습니다.  

butter’는 ‘cheese’ 는 포함할 수도 있는 콘텐츠를 찾습니다. 

(cheese OR butter) AND chalk 

chalk’가 제목인 것을 찾습니다.  

생성되거나 수정된 콘텐츠를 created나 modified 키워드를 통해 

따릅니다.   

created:[20000101 TO 20131231] 

modified:[20000101 TO 20131231] 

 와일드카드 문자를 사용할 수 있으며, 문자열의 가장 앞을 제외한

있습니다. 예로 http*.atlassian.* 등은 가능하지만,*.atlassian.* 

or ?ttps://confluence.atlassian는 불가능합니다. 

여러 개를 대체할 수 있습니다.  

 

.  

 찾습니다. 시간은 숫자로 

제외한 찾는 문자열의 

,*.atlassian.* 
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검색에서 물음표를 와일드카드로

다음과 같이 사용합니다. 

b?tter 

 

문자문자문자문자 여러여러여러여러 개를개를개를개를 대체할대체할대체할대체할 경우경우경우경우 

검색에서 *를 와일드카드로 사용할

사용합니다: 

chick* 

 

와일드카드를와일드카드를와일드카드를와일드카드를 여러여러여러여러 개개개개 사용할사용할사용할사용할 경우경우경우경우

검색에서 여러 개의 와일드 카드를

등을 찾게 됩니다. 

c*c* 

또한 한 번의 검색에서 와일드 카드

‘chickpea’는 찾지 않습니다

c*c? 

NOTE. 컨플루언스는컨플루언스는컨플루언스는컨플루언스는

cheese 를를를를 찾아주지찾아주지찾아주지찾아주지

 

Proximity 검색검색검색검색 

~문자와 숫자를 조합하여 두 단어

같은 경우 ‘Octagon blog post

않습니다.  
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와일드카드로 사용할 수 있습니다. 예로 'butter', 'bitter', 'better', or 'batter'

.  

사용할 수 있습니다. 예로 ‘chicken' or 'chickpea' 등을 찾을

경우경우경우경우 

카드를 사용할 수도 있습니다. 다음과 같은 경우 'chick', 'coconut', or 'chickpea'

카드 문자를 조합할 수 도 있습니다. 다음과 같은 경우 'chick’

않습니다. 

컨플루언스는컨플루언스는컨플루언스는컨플루언스는 맨맨맨맨 앞에앞에앞에앞에 오는오는오는오는 *은은은은 찾지찾지찾지찾지 않는다는않는다는않는다는않는다는 것을것을것을것을 기억하세요기억하세요기억하세요기억하세요. *heese

찾아주지찾아주지찾아주지찾아주지 않습니다않습니다않습니다않습니다.  

단어 사이에 있는 한 개 또는 여러 개의 단어에 대해 검색합니다

Octagon blog post’를 찾습니다. 숫자가 1이기에 ‘Octagon team blog post

 

'butter', 'bitter', 'better', or 'batter' 등을 찾을 시 

찾을 시 다음과 같이 

'chick', 'coconut', or 'chickpea' 

'chick’는 찾지만 

. *heese 는는는는 

검색합니다. 예를 들어 다음과 

Octagon team blog post’는 검색되지 
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“octagon post”~1 

또한 다음과 같은 문장은 숫자에

검색을 이용하십시오.   

“octagon post”~0 

 

Range 검색검색검색검색 

특정 범위 내에서 이름을 

[adam TO ben] 

NOTE. 이이이이 문법에서문법에서문법에서문법에서 

 

Fuzzy 검색검색검색검색 

~문자를 사용하여 비슷한

스펠링이 확실치 않을 경우

Octogan~ 

 

Combined  검색검색검색검색 

앞서 나온 여러 방법들을 

o?tag* AND past~ AND ("blog" 

 

Macros 검색검색검색검색 

매크로를 사용중인 콘텐츠라면

뒤 콜론 뒤에 매크로의 이름을
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숫자에 0이 올 수 없으므로 잘못된 문법입니다. 이와 같이 검색이

 찾을 때 대문자 ‘TO’를 사용할 수 있습니다. 

 AND 는는는는 사용할사용할사용할사용할 수수수수 없습니다없습니다없습니다없습니다. 

비슷한 스펠링을 찾을 수 있습니다. 예로 만약 octagon 을

경우 다음과 같이 사용할 수 있습니다.  

 함께 조합하여 사용할 수도 있습니다.  

o?tag* AND past~ AND ("blog" AND "post") 

콘텐츠라면, 이 방법으로도 검색할 수 있습니다. macroName: 

이름을 적습니다. 예로 다음과 같이 검색할 수 있습니다

 

검색이 필요할 경우 phrase 

을 찾고 싶지만, 

. macroName: 을 앞에 적은 

있습니다.   
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macroName:excerpt-include*

 

Labels 검색검색검색검색 

특정 레이블을 가진 콘텐츠에서

사용 예시와 그에 따른 결과표입니다

Searching forW 

recipe labelText:chocolate

recipe AND labelText:chocolate

labelText:cake OR labelText:chocolate

labelText:cake AND labelText:chocolate

 

8.2 컨플루언스컨플루언스컨플루언스컨플루언스 검색검색검색검색 필드필드필드필드 

특정특정특정특정 필드에서필드에서필드에서필드에서 콘텐츠콘텐츠콘텐츠콘텐츠 검색검색검색검색 

컨플루언스 데이터는 검색할

뒤 찾는 내용을 콜론을 붙여서

title:"Some Title" 

 

labelText:chalk 

필드 명시는 오직 콜론 앞에 오는

“Heading” 은 기본 필드에서 

title:Some Heading 

 

컨플루언스컨플루언스컨플루언스컨플루언스 검색검색검색검색 필드필드필드필드 

개인 정보 
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include* 

콘텐츠에서 ‘labelText:’ 를 앞에 붙임으로써 검색할 수 있습니다

결과표입니다. 

Returns content thatW 

recipe labelText:chocolate contains the word 'recipe' or has the label 

'chocolate' 

recipe AND labelText:chocolate contains the word 'recipe' and has the label 

'chocolate' 

labelText:cake OR labelText:chocolate has the label 'cake' or the label 'chocolate'

labelText:cake AND labelText:chocolate has both labels 'cake' and 'chocolate'

 

검색할 수 있는 특정 필드에 저장되며, 검색을 위해선

붙여서 검색합니다. 다음은 그 예시입니다.  

오는 부분만 적용됩니다. 예를 들어 아래와 같은 경우, 제목 필드의

 따로 찾게 됩니다.  

 

있습니다. 아래는 

contains the word 'recipe' or has the label 

contains the word 'recipe' and has the label 

or the label 'chocolate' 

has both labels 'cake' and 'chocolate' 

위해선 필드 이름을 적은 

필드의 “Some” 을 찾고 
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Name Indexed

handle true 

type true 

urlPath true 

fullName true 

title true 

labelText true 

modified true 

created true 

contentBody true 

 

페이지 

Name Indexed

handle true 

type true 

urlPath true 

title true 

spacekey true 

labelText true 

modified true 

created true 

contentBody true 

macroName true 

 

블로그 

Name Indexed

handle true 

type true 

urlPath true 

title true 

spacekey true 

labelText true 
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Indexed Stored Tokenised 

true false 

true false 

true false 

true true 

true false 

true true 

true false 

true false 

true true 

Indexed Stored Tokenised Notes 

true false  

true false  

true false  

true true  

true false  

true true  

true false  

true false  

true true  

true false 페이지에서 매크로를 사용할

Indexed Stored Tokenised Notes 

true false  

true false  

true false  

true true  

true false  

true true  

 

Notes 

 

 

 

 

 

 

 

 

 

사용할 경우 
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modified true 

created true 

contentBody true 

macroName true 

 

첨부파일 

Name Indexed

handle true 

type true 

urlPath true 

filename true 

title true 

comment true 

spacekey true 

modified true 

created true 

contentBody true 

 

메일 아이템 

Name Indexed

handle true 

type true 

urlPath true 

title true 

spacekey true 

messageid true 

inreplyto true 

recipients true 

labelText true 

modified true 

created true 

contentBody true 

Atlassian Confluence 5.8.X User Guide 

Page 106 

true false  

true false  

true true  

true false 페이지에서 매크로를 사용할

Indexed Stored Tokenised Notes 

true false  

true false  

true false  

true true  

true false  

true true  

true false  

true false  

true false  

true true  

Indexed Stored Tokenised Notes 

true false  

true false  

true false  

true true  

true false  

true false  

true false  

true true  

true true  

true false  

true false  

true true  

 

사용할 경우 
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8.3 사용자사용자사용자사용자 디렉터리디렉터리디렉터리디렉터리 검색검색검색검색 

사용자 디렉터리는 컨플루언스 

사용자 디렉터리는 컨플루언스에

포함합니다. 

사용자 디렉터리는 외부 유저 관리에

않습니다.  

 

사용자사용자사용자사용자 디렉터리디렉터리디렉터리디렉터리 보기보기보기보기 

스크린 상단의 People를 선택합니다

 

사용자사용자사용자사용자 찾기찾기찾기찾기 

특정 사용자를 찾기 위해선 검색

선택합니다. 

• 해당 컨플루언스 사이트를

• 개인 스페이스를 가진

 

사용자들의사용자들의사용자들의사용자들의 활동활동활동활동 팔로잉팔로잉팔로잉팔로잉 

컨플루언스의 네트워크 기능은 

다른 사용자들의 디렉토리의 프로필에

• 누군가를 팔로잉하기

나타나는 Follow를

• 누군가의 팔로잉을 그만하려면

나타나는 Stop Following
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 사이트에 로그인하도록 허가된 사람들의 리스트를 보여줍니다

컨플루언스에 로그인한 어떤 사람,  또는 그들에 의해 만들어진 계정을 가진

관리에 의해 로그인은 가능하지만 한 번도 로그인하지 않은 사람에

선택합니다.  

검색 박스에 해당 사용자의 이름과 성 또는 이름이나 성만 입력한

사이트를 사용하는 모든 사용자를 보려면 All People를 선택합니다

가진 사용자들만 보려면 People with Personal Spaces를

 컨플루언스 사이트 내에서 다른 사용자들의 활동을 ‘follow’

프로필에 마우스를 올린 뒤 다른 사람을 팔로잉할 수 있습니다

팔로잉하기 시작하려면, 해당 사용자의 이름이나 프로필 사진에 마우스를

를 선택합니다.  

그만하려면, 해당 사용자의 이름이나 프로필 사진에 마우스를

Following을 선택합니다. 

 

보여줍니다.  

가진 사람들을 

사람에 대해서는 포함하지 

입력한 뒤 Search를 

선택합니다. 

를 선택합니다. 

’ 할 수 있도록 해줍니다. 

있습니다.  

마우스를 올리고 프로필 팝업에 

마우스를 올리고 프로필 팝업에 
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사용자사용자사용자사용자 디렉디렉디렉디렉터터터터리리리리 예시예시예시예시 

NOTE.  

� 사용자사용자사용자사용자 디렉디렉디렉디렉

hCard 마이크로포맷을마이크로포맷을마이크로포맷을마이크로포맷을

대표하는대표하는대표하는대표하는 오픈오픈오픈오픈

� 기본적으로기본적으로기본적으로기본적으로

해당해당해당해당 사용자들을사용자들을사용자들을사용자들을

showDeactivatedUsers

예시입예시입예시입예시입니다니다니다니다

http://my.confluence.com/dopeopledirectorysearch.action?showDeactivatedU
sers=true 

� 기본적으로기본적으로기본적으로기본적으로

경우경우경우경우 사용자사용자사용자사용자

위해선위해선위해선위해선 URL

가능합니다가능합니다가능합니다가능합니다

http://my.confluence.com/dopeopledirectorysearch.action?showExternallyDe
letedUsers=true 

� 컨플루언스컨플루언스컨플루언스컨플루언스

Directory 
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디렉디렉디렉디렉터터터터리리리리는는는는 다양한다양한다양한다양한 마이크로포맷마이크로포맷마이크로포맷마이크로포맷 이이이이 활성화된활성화된활성화된활성화된 도구들의도구들의도구들의도구들의 쉬운쉬운쉬운쉬운 통합을통합을통합을통합을

마이크로포맷을마이크로포맷을마이크로포맷을마이크로포맷을 사용합니다사용합니다사용합니다사용합니다. hCard 는는는는 사용자사용자사용자사용자, 회사회사회사회사, 조직과조직과조직과조직과 장소들을장소들을장소들을장소들을

오픈오픈오픈오픈 데이터데이터데이터데이터 포맷입니다포맷입니다포맷입니다포맷입니다.  

기본적으로기본적으로기본적으로기본적으로, 비활성화된비활성화된비활성화된비활성화된 사용자들의사용자들의사용자들의사용자들의 경우경우경우경우 사용자사용자사용자사용자 디렉디렉디렉디렉터터터터리에서리에서리에서리에서 제외되게제외되게제외되게제외되게

사용자들을사용자들을사용자들을사용자들을 다시다시다시다시 디렉터리에디렉터리에디렉터리에디렉터리에 넣기넣기넣기넣기 위해선위해선위해선위해선 URL 에에에에 

showDeactivatedUsers 파라메터를파라메터를파라메터를파라메터를 추가함으로써추가함으로써추가함으로써추가함으로써 가능합니다가능합니다가능합니다가능합니다. 다음은다음은다음은다음은

니다니다니다니다. 

http://my.confluence.com/dopeopledirectorysearch.action?showDeactivatedU

기본적으로기본적으로기본적으로기본적으로, 외부에서외부에서외부에서외부에서 삭제된삭제된삭제된삭제된 사용자사용자사용자사용자 (예로예로예로예로, LDAP 레포지터리에레포지터리에레포지터리에레포지터리에 의해의해의해의해 

사용자사용자사용자사용자 디렉터리에서디렉터리에서디렉터리에서디렉터리에서 제외되게제외되게제외되게제외되게 됩니다됩니다됩니다됩니다. 해당해당해당해당 사용자들을사용자들을사용자들을사용자들을 다시다시다시다시 디렉터리에디렉터리에디렉터리에디렉터리에

URL 에에에에 showExternallyDeletedUsers 파라메터를파라메터를파라메터를파라메터를 추가함으로써추가함으로써추가함으로써추가함으로써

가능합니다가능합니다가능합니다가능합니다. 다음은다음은다음은다음은 그그그그 예시입예시입예시입예시입니다니다니다니다. 

http://my.confluence.com/dopeopledirectorysearch.action?showExternallyDe

컨플루언스컨플루언스컨플루언스컨플루언스 관리자는관리자는관리자는관리자는 사용자사용자사용자사용자 디렉터리를디렉터리를디렉터리를디렉터리를 숨길숨길숨길숨길 수수수수 있으며있으며있으며있으며, 숨길숨길숨길숨길 경우경우경우경우 People 

Directory 옵션을옵션을옵션을옵션을 보지보지보지보지 못하게못하게못하게못하게 됩니다됩니다됩니다됩니다.  

 

 

통합을통합을통합을통합을 위해위해위해위해 

장소들을장소들을장소들을장소들을 

제외되게제외되게제외되게제외되게 됩니다됩니다됩니다됩니다. 

다음은다음은다음은다음은 그그그그 

http://my.confluence.com/dopeopledirectorysearch.action?showDeactivatedU

의해의해의해의해 삭제된삭제된삭제된삭제된)의의의의 

디렉터리에디렉터리에디렉터리에디렉터리에 넣기넣기넣기넣기 

추가함으로써추가함으로써추가함으로써추가함으로써 

http://my.confluence.com/dopeopledirectorysearch.action?showExternallyDe

eople 



Confidential 

 

8.4 최근최근최근최근 본본본본 페이지와페이지와페이지와페이지와 블로그블로그블로그블로그

컨플루언스의 Recently Viewed 

항목들로 이동할 수 있도록 도와줍니다

최근최근최근최근 방문했던방문했던방문했던방문했던 콘텐츠콘텐츠콘텐츠콘텐츠 보기보기보기보기 

1. 우측 상단의 프로필 

2. 재 방문하고 싶은 페이지의

 

리스트에 필터를 걸기 위해서. 페이지의

컨플루언스의 Search 필드에 

 

 

 

9 참고자료참고자료참고자료참고자료 

 

Confluence: https://confluence.atlassian.com/doc/confluence

135922.html 
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블로그블로그블로그블로그 포스트포스트포스트포스트 

Recently Viewed 리스트는 본인이 최근 방문했던 페이지와 블로그 포스트를

도와줍니다. 

 사진을 선택한 뒤, Recently Viewed를 선택합니다. 

페이지의 제목을 선택합니다. 

페이지의 제목 중 일부를 적거나, Filter 필드에 사용자의 이름을

 검색을 위해 작성할 때 가장 최근 본 10개의 페이지가 나타나게됩니다

https://confluence.atlassian.com/doc/confluence-documentation

 

포스트를 기억하며, 쉽게 해당 

이름을 적습니다.  

나타나게됩니다.  

documentation-home-

 


